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■ Introduction

Welcome to UNIVERGE® UM8500.
This chapter provides a basic introduction to the UNIVERGE UM8500 messaging system and
instructions for accessing the system by phone or by Internet.

In this Chapter...
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Introducing
UNIVERGE
UM8500

On the messaging system, you and the other associates in the organization are subscribers.
Subscribers can manage voice messages, faxes, and e-mail messages from a touchtone phone, a
computer, or over the Internet.

New Features
This release of the messaging system provides a new feature that enhances the unified
messaging capabilities. The new feature for this release is:
Unified Messaging for Microsoft® Outlook®. A feature that allows you to
manage e-mail, voice, and fax messages through your Outlook Inbox.

Your Features
The following features can be included in a full-featured unified messaging system. Your
system administrator can tell you which of these features are available in your organization.
Available

Feature Name

Feature Description

UM8500
Assistant

The UM8500 Assistant is a Web-based application that
enables you to personalize your messaging system phone
settings.

Text-tospeech

Text-to-speech enables you to hear the text portion of e-mail
messages and meeting requests using computer speakers or
a phone.

FindMe
FollowMe

Your messaging system determines the best way to contact
you and manage messages based upon your schedule and
other system information.

Unified
Messaging for

This feature enables you to manage e-mail, voice, and fax
messages in your Outlook Inbox.

Microsoft®
Outlook®
ViewMail® for
Microsoft®
Outlook®
Fax option

If your messaging system uses an Exchange message store,
this feature enables you to manage e-mail, voice, and fax
messages in your Outlook Inbox.
You can use a third-party fax program to send and receive
fax messages from a computer the same way you send and
receive other messages within Outlook.
You can print your fax and e-mail messages on a fax
machine from any touchtone phone.
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ViewCall®

ViewCall allows you to view and manage your phone calls
directly from your desktop computer, instead of using the
phone handset.

VideoMail®

VideoMail extends the messaging and collaboration features
by embedding live video, audio, and screen capture streams
into e-mail messages.
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About This Guide

This document provides instructions for using a full-featured messaging system. Depending on
how the messaging system is configured in your organization, some procedures are different or
are not applicable. This document explains how to manage voice messages, fax messages, and
change settings that define how you work with the messaging system.
For detailed information about the messaging system set up in your organization contact your
system administrator. For information about managing e-mail messages, or using your e-mail
application, refer the e-mail application documentation.
If your system has the ViewCall and/or VideoMail features installed, see the online help
associated with these features for detailed information about using them.

User Tools
There are several tools that can be used to work with the messaging system: the phone, the UM8500
Assistant, and Unified Messaging for Outlook. The procedures in this document provide information
for using these tools, but depending on how the messaging system in your organization is
configured, some procedures are not applicable.
This document includes space for reference information on page 5. Write the phone numbers
for calling the messaging system; your ID; the Web site address for the UM8500 Assistant; the
server name; and the name and phone number of your system administrator.

Document Conventions
This document uses the following conventions:
●

Key Names. Names of keys on the keyboard are shown in capital letters. For example,
ESC, ALT, SHIFT and so on.
When two keys must be pressed simultaneously they are joined by a + sign; for example,
ALT+TAB.

●

●

●

Icon and Button Names. Names of icons and buttons on the application are shown
in bold font. The capitalization matches the user interface. For example, OK, Ok,
DELETE, or Delete are acceptable.
Menu Selections. Menu selections are shown in a distinctive font.
For example: File > Save and Actions > New Voice Message.
User Input. Information you are required to type is shown in a distinctive font.
For example, type msgorder.
Caution is required when typing a zero (0) or capital-O (O); a one (1) or a lowercase l.
NOTE
On the command line prompt, always press ENTER after typing a command.

●

●

Phone Keys. Procedures written specifically for the phone use special icons for keys on
the phone key pad.
For example, *, #, 1, represent pressing the star key, pound key, or one (1) on the phone
keypad.
Placeholder Text. Variable text that is replaced by specific text is shown in italics
between angle brackets. For example;
vm_ctl <action> <service>

where <action> = the command and
<service> = the name of the service.
●
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Hypertext Links. When viewing the Adobe® Acrobat® PDF document, links to other
locations within the document and external Internet links appear in blue. Click a link to go
to the referenced topic, page, or URL.
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●

Notes, Cautions, and Warnings. Text for notes, cautions, and warnings appear as
shown below:
NOTE
A note provides additional information to supplement the main text. A note
provides helpful information, but is not essential to understanding the current
topic.
CAUTION!
A caution advises you that failure to avoid or to take a specific action might
lead to unwanted or undesirable results.
WARNING!
A warning advises you that failure to avoid or to take a specific action might
result in physical harm to the user, damage to the hardware or loss of data.

●

Procedural Tools. Procedures for a specific tool are marked with the following icons:
Icon

Tool
Phone. Use the phone to listen to and send messages, set personal
profiles, and set personal preferences for greetings, playback, call
transfer/screening, message notification, groups, and e-mail.
E-mail Inbox. Use your e-mail tool to send or listen to your unified
messages.
UM8500 Assistant. Use the Web-based application, UM8500 Assistant,
to read and send messages, set personal profiles, and set personal
preferences for greetings, playback, call transfer/screening, message
notification, groups, and e-mail.
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Phone Numbers,
Names, and
Addresses
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Use this space to record information for your messaging system:
Messaging system internal phone

_______________________________________

Messaging system external phone

_______________________________________

Personal ID

_______________________________________

UM8500 Assistant URL

_______________________________________

Server name or IP Address

_______________________________________

System administrator

_______________________________________

System administrator-phone number

_______________________________________
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■ Getting Started

The first step is enrollment. All subscribers must enroll to use the messaging system. Use the
phone to enroll as a subscriber. During enrollment record your name, a greeting, set a
password, and specify whether you are listed in the phone directory.
To enroll, call the messaging system from an inside phone or using a phone outside of the
organization. After enrollment, you can use the phone to log on to the messaging system to
check and send messages, and change any messaging system preferences.

In this Chapter...
Enrolling on UNIVERGE UM8500 ................................................................................. 8
Logging on to the Messaging System .......................................................................... 9
Accessing the UM8500 Assistant............................................................................... 10
Logging Off the UM8500 Assistant ............................................................................ 11
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Enrolling on
UNIVERGE
UM8500

There are two ways to enroll. You can use an internal phone or an external phone to call the
messaging system. The information that the messaging system requests during enrollment
might include asking you for your ID and a password. The system administrator assigns the ID
and temporary password.
NOTE
Depending on how the messaging system is set up in your organization, the
following procedure might not be required.

USING A PHONE
To Enroll
1 Dial the internal or external messaging system phone number.
2 If you dialed the external phone number, press * when the messaging system answers.
3 Enter your ID, if required, then press #.
4 Enter a password, if required.
5 If prompted, follow the instructions to:
●

Record your name. Record your name.

●

Record a greeting. Record a greeting.

●

Set a new password. Create a password.

●
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Select whether you are listed in directory assistance. Select if you want
to be listed in the organizational phone directory.
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Logging on to the
Messaging
System

After you enroll, use this procedure whenever you log on to the messaging system to manage
messages and settings by phone.
The information that the messaging system asks for when you log on depends on where you are
calling from:
Inside your organization. The messaging system might ask for your password.
Outside your organization. The messaging system asks for your ID and might ask for
your password.

USING A PHONE
To Log on to the Messaging System
1 Dial the internal or external the messaging system phone number.
2 If you dialed the external phone number, press * when the messaging system answers.
3 Enter your ID, if required, then press #.
4 Enter your password, if required.
NOTE
You might be able to skip some or all of these steps when you call the
messaging system from your desk. The office touchtone phone might have a
button that automatically calls the messaging system. See your system
administrator for more information.
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Accessing the
UM8500 Assistant

Use this procedure to access the UM8500 Assistant using a Web browser. Use the UM8500
Assistant to manage messaging system settings for: greetings, call transfer, message
notification, and distribution lists.
After opening the UM8500 Assistant, you might have to type log on information. The
configuration of the messaging system in your organization determines if log on information is
required to proceed.
You need to know the server name, your user name, and your password. See your system
administrator for this information.

USING THE UM8500 ASSISTANT
To Access the UM8500 Assistant
1 Start Internet Explorer.
2 Type http://<server name>/saweb/aadefault.htm, then press ENTER.

If you do not know the <server name>, contact your system administrator.
3 In the UM8500 Assistant log on page, type your extension and messaging system phone

password.

Tip
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Add the UM8500 Assistant site to your list of favorites in your Web
browser to eliminate having to type the Web address each time you
access the UM8500 Assistant.
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Logging Off the
UM8500 Assistant

Use this procedure whenever you log off the UM8500 Assistant. To prevent others from
accessing your mailbox settings, close the Web browser after you log off.

USING THE UM8500 ASSISTANT
To Log Off of UM8500 Assistant
1 In the UM8500 Assistant Navigation pane, click Log off.
2 To close Internet Explorer, select File > Close.
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■ The tools you use

This section explains more about three of the tools used to manage messages and messaging
system settings:
Icon

Tool
Phone. Use the phone to listen to messages and send messages, set
personal profiles, and set personal preferences for greetings, playback, call
transfer/screening, message notification, groups, and e-mail.
E-mail Inbox. Use your e-mail tool to manage your unified messages
(e-mail, fax, and voice messages).
UM8500 Assistant. Use the UM8500 Assistant to read and send messages,
set personal profiles, and set personal preferences for greetings, playback,
call transfer/screening, message notification, groups, and e-mail.

In this Chapter...
Messaging by Phone ............................................................................................... 14
Working with the UM8500 Assistant .......................................................................... 15
Using the Media Master Control Bar .......................................................................... 16
Messaging from your E-mail Inbox............................................................................ 17
The Unified Messaging for Outlook Window.............................................................. 17
The Audio Control Bar........................................................................................... 17
The ViewMail for Outlook Window........................................................................... 18
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Messaging by
Phone

When you interact with the messaging system by phone, you hear the messaging system
conversation. The recorded instructions in the conversation guides you through sending
messages, managing messages, and changing settings.
There are two types of conversation menus available. Your system administrator can set up one
of the conversation menus for you to use:
Full menus. These conversation menus provide comprehensive instructions for new
users.
Brief menus. These conversation menus provide abbreviated versions of menus for
experienced users.
Select conversation menu options by pressing the corresponding touchtone keys on the phone
keypad.

Help
❚

For conversation Help, press 0 on your phone keypad.

Use these keys anytime
TASK

Cancel last action or back up to
previous point in the messaging
system conversation
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KEY

*

TASK

KEY

Skip ahead to next point in the
messaging system conversation

#
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Working with the
UM8500 Assistant

The UM8500 Assistant is a Web application that is accessed using a Web browser. The UM8500
Assistant pages contain settings that control how you and callers interact with the messaging
system by phone. Use the UM8500 Assistant to change greetings, call transfer settings, message
notification settings, and message distribution lists.
Save Help
icon icon

Subscriber name

Navigation
pane

Log off
link

The links displayed in the Navigation pane change depending on which UM8500 Assistant page
is opened. Click a link to move from one page to another.

Tip

Click the Save icon to save changes. When you have unsaved
changes, an asterisk (*) appears next to your name as a reminder.
The asterisk disappears when you save your changes.

Using UM8500 Assistant you can listen to and manage your voice messages.
CAUTION!
Do not use the Web browser Back button to return to a previously viewed
page. Use the UM8500 Assistant navigation pane links to move from
page-to-page.

Help
Click the Help icon for UM8500 Assistant online help. Question mark links appear next to each
field or setting that has a corresponding help topic. Click
to see the help topic.
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Using the Media
Master Control
Bar

The Media Master Control bar appears in ViewMail for Microsoft Outlook and on some UM8500
Assistant pages where greetings or names are recorded.
In ViewMail for Outlook, use the Media Master control bar to play and record voice messages.
In the UM8500 Assistant pages, use the control bar to record names and greetings.
Use the Options menu on the Audio Control bar to work with other sound (.WAV) files. The following
sound file options are available:
New. Erase a recording to rerecord.
Paste. Paste a sound recording the same way you paste text in a text file.
Paste from file. Paste another sound file to a recording.
Copy. Copy a sound recording the same way you copy text in a text file.
Copy to file. Copy the recording to a sound file that you name.
Use the Options menu to set your recording and playback devices, if applicable. See “Changing
Recording and Playback Settings” on page 57.

Options menu
Sound file
options

Record Recording Volume
length
control
Stop

Speed
control

Play

UNIVERGE UM8500 USER GUIDE
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Messaging from
your E-mail Inbox

If your organization has Unified Messaging for Microsoft Outlook installed, you can send, listen
to, and manage voice messages from Outlook. The Unified Messaging form has an Audio
Control bar, which is used to record and play messages.
If your organization uses an Exchange message store and has ViewMail for Microsoft Outlook
installed, you can send, listen to, and manage voice messages from Outlook. The ViewMail form
has a Media Master control bar, which is used to record and play messages. See “Using the
Media Master Control Bar” on page 16.
If you do not have Unified Messaging for Microsoft Outlook or ViewMail for Microsoft Outlook
installed, voice messages are stored and attached as WAV files to e-mail messages.
In unified messaging systems voice messages, fax messages, and e-mail messages are all
collected in the e-mail inbox.

The Unified Messaging for Outlook Window

Toolbars
Audio
Control Bar
Record
Play

The Audio Control Bar
The Audio Control bar appears on Unified Messaging for Outlook messages that have voice
messages associated with them. The Audio Control bar is used to record and play messages.
Master
Volume
WAV
Volume
Microphone
Volume

Playback/Recording Tracking

Show/Hide
Volume Controls

Record
Play

Message Length/Number

The Audio Control bar has the following options:
Record. Starts and stops recording audio from the microphone.
Play. Starts and stops playing recorded audio.
Playback/Recording Tracking. Tracks the playback/recording audio position.
Message Length/Number. Shows the length, in seconds, of the recorded audio. If an
e-mail has multiple audio messages attached, it shows which message is played.
Show/Hide Volume Controls. Shows or hides the volume controls.

UNIVERGE UM8500 USER GUIDE

THE TOOLS YOU USE

17

Master Volume. Adjusts the speaker volume.
WAV Volume. Adjusts the playback audio volume.
Microphone Volume. Adjusts the microphone volume.

The ViewMail for Outlook Window

Toolbars

Media
Master
control bar
Option
Menu

Stop
Record

■ Checking messages

Check messages by phone, e-mail inbox, or the UM8500 Assistant. Once you have listened to a
message by phone, it becomes an old, saved, or read message—unless you mark it as new or
delete it.
If the messaging system is not configured to retain deleted messages, the message is
permanently removed.
If the messaging system is configured to retain deleted messages; the deleted messages are
moved to the Deleted Items folder. Messages in the Deleted Items folder can be accessed by
phone, e-mail, or the UM8500 Assistant. Deleted a messages can be restored from the Deleted
Items folder to the Inbox or any other Outlook folder. Once a message is removed from the
Deleted Items folder, it is permanently removed from the system.
You should periodically empty old messages from the Deleted Items folder. If you do not do
this, you might eventually exceed the storage limitations of your messaging system account,
and find that you are unable to send any messages by phone. If you find that you cannot send
messages by phone, try removing a few items from the Deleted Items folder. When your total
message store is below the size limitation, you are able to send new messages.

In this Chapter...
Checking Messages ................................................................................................ 20
Forwarding a Message ............................................................................................ 24
Replying to a Message ............................................................................................ 26
Returning a Call ..................................................................................................... 28
Delivering a Fax ..................................................................................................... 29
Checking E-mail Messages in an External Mailbox ....................................................... 30
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Checking
Messages

You can check messages by phone or, depending on your system configuration, using your
e-mail inbox or the UM8500 Assistant Inbox.
Fax option. The messaging system plays the message summaries and any voice
annotations on your fax messages.
Text-to-speech option. The messaging system also plays e-mail messages and
meeting requests. You can record a reply to an e-mail or meeting request, and you can
accept or decline meeting requests by phone.
The types of messages you hear when checking messages by phone and what you hear in
message summaries can be set in the UM8500 Assistant.

Tip

Old messages are not automatically deleted. Frequently delete old
messages to save space.

USING A PHONE
To Check Messages
1 Call the messaging system and log on.
2 Press 1 to hear new messages, or press 3 to review old messages.
3 Use the following keys to manage your messages and to control playback.

Use these keys during a message
TASK

Repeat message
Save
Delete message
Change volume

KEY

1
2
3
5

TASK

KEY

Rewind

7
8
0

Pause or Continue
Message playback help

Use these keys after a message
TASK

Repeat
Save
Delete
Return call
Reply to all
Reply to sender

KEY

1
2
3
41
44
4#

TASK

KEY

Forward message

5
6
7

Mark as new
Reverse
Deliver an e-mail or fax to a fax

8

phone number *
Hear summary

9

* Available only with the fax option.

Use these keys anytime
TASK

Cancel or back up
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KEY

*

TASK

KEY

Skip or move ahead

CHECKING MESSAGES

#
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USING E-MAIL
To Check Messages
1 Open your Outlook Inbox.
2 Follow the steps that apply to your setup.

Without Unified Messaging for Outlook or ViewMail for Outlook. Open the
e-mail message with WAV file attachment. Double-click the attachment to play it on your
computer speakers with your multi-media software.
With Unified Messaging for Outlook. Open the e-mail message and click Play on
the Audio Control bar to play the message.
or
Open the e-mail message with the fax attachment and double-click the attached file to start
the viewer program on your computer.

Tip

To have voice messages play automatically when you open them, in
Outlook click Tools > Options, click on the Unified Messaging
tab and select Play message automatically.

Voice Message in Unified Messaging for Outlook
Message toolbar
Play

In the voice or fax message, use the buttons on the message toolbar to handle the message
the same way you handle e-mail messages.

Fax Message in Unified Messaging for Outlook
Message toolbar

Fax file

Or, in the fax message, click the print button on the toolbar or click File > Print to print
the fax.
With ViewMail for Outlook. Open the e-mail message and click Play on the Media
Master control bar to play the message.
or
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Open the e-mail message with the fax attachment and double-click the attached file to
start the viewer program on your computer.

Tip

To have voice messages play automatically when you open them, in
Outlook click Tools > ViewMail options, and then select Play
message automatically.

Voice message in ViewMail for Outlook
Message
toolbar

Play

In the voice or fax message, use the buttons on the message toolbar to handle the message
the same way you handle e-mail messages.

Fax message in ViewMail for Outlook
File menu
Message toolbar

Fax file

Or, in the fax message, click the print button on the toolbar or click File > Print to print the
fax.

USING THE UM8500 ASSISTANT
To Check Messages
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Messages, click Inbox. The messages in your inbox are

shown.

Inbox
messages
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3 Under the From column, click the message to check. The voice message appears.

Play messages

4 Click Play or VoiceMessage.wav to listen to the voice message.
5 After listening to the message you can:
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■

In the navigation pane, under Messages, click Inbox to return to your inbox.

■

Click Save as New to keep the voice message as a new message.

■

Click Delete to delete the voice message.
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Forwarding a
Message

You can forward a message as is or record an introduction that plays before the forwarded
message. You can forward new or saved messages.
Forwarded messages can have an attached recording or no attachment.

USING A PHONE
To Forward Messages
1 After listening to the message, press 5.
2 Follow the messaging system conversation to address the forwarded message.
NOTE
When addressing a message, press
number mode.

# # to switch between spelling and

3 Press 2 to record an introduction. After recording, press #, or press 3 for message

options, or press # to forward the message as is.
4 Press 1 for message options, or press # to forward the message as is.
5 Follow the conversation to handle the original message.

Message options
OPTION

KEY

Change addressing
Change recording

1
2

OPTION

KEY

Set special delivery
Review message

3
4

USING E-MAIL
With Unified Messaging for Outlook to Forward Messages
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 In your Outlook Inbox, select a voice message and click Forward With Voice.
2 Type the recipients’ names.
3 On the Audio Control bar, click Record and speak into the microphone to record an

introduction to the forwarded message.
4 When you finish recording, click Stop.
5 Add text and attachments as appropriate.
6 Click Send.

USING E-MAIL
With ViewMail for Outlook to Forward Messages
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 In your Outlook Inbox, select a voice message and click Forward.
2 Type the recipients’ names.
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3 On the Media Master control bar, click Record to record an introduction with your

recording device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
4 When you finish recording, click Stop.
5 Add text and attachments as appropriate.
6 Click Send.
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Replying to a
Message

When you reply by phone to any type of message, your response is a voice message. You can
reply by phone to everyone who received the original message, or you can reply only to the
sender.
By phone or with Unified Messaging for Outlook or ViewMail for Outlook, you can record a
reply only to another voice message from a subscriber.

USING A PHONE
To Reply to a Message
1 After listening to the message, press 4, or if the original message was sent to more than

one person, press 4 4 to reply to all, or press 4 # to reply only to the sender.
2 Record your reply. then press # to finish recording.
NOTE
You cannot use the phone to reply to a message sent by an unidentified caller.
3 Press 1 for message options, or press # to send the reply.
4 Follow the conversation to handle the original message.

Use these keys to set message options
OPTION

KEY

Change addressing

1
2

Change recording

OPTION

KEY

Set special delivery

3
4

Review message

Use these keys as you record an introduction
TASK

KEY

Pause or continue

8

TASK

KEY

End recording

#

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING E-MAIL
With Unified Messaging for Outlook to Reply to a Message
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 In your Outlook Inbox, select a voice message and click Reply With Voice or Reply to

All With Voice.
WARNING

Do not reply to a message sent by an unidentified caller.
2 On the Audio Control bar, click Record and speak into the microphone to record a reply.
3 When you finish recording, click Stop.
4 Add text and attachments as appropriate.
5 Click Send.

UNIVERGE UM8500 USER GUIDE

CHECKING MESSAGES

26

USING E-MAIL
With ViewMail for Outlook to Reply to a Message
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 In your Outlook Inbox, select a voice message and click Reply.
WARNING
Do not reply to a message sent by an unidentified caller.
2 On the Media Master control bar, click Record to record an introduction with your

recording device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
3 When you finish recording, click Stop.
4 Add text and attachments as appropriate.
5 Click Send.
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Returning a Call

If the call return feature is licensed and installed, you can immediately return a call, from the
Inbox or by phone, to the caller who left you a message after listening to a message. See “To
Return a Call” on page 28.
The messaging system uses caller ID information received from your phone service provider.
You can use the UM8500 Assistant to set up the system to ask callers to enter their phone
number before they are transferred to your extension. See “Asking Callers to Enter a Callback
Phone Number” on page 118.
If a returned call is not answered, disconnect then call the messaging system again to continue
using the messaging system by phone. If the line is busy, the messaging system tells you that the
call could not be connected and returns you to your voice mailbox.
The return call feature might not be available for a message because phone numbers have been
restricted. The messaging system tells you if return call is not available for a specific message.
The live record feature is not available during a return call.

USING A PHONE
To Return a Call
❚
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Delivering a Fax

With the ActiveFax option, you can deliver your faxes to a fax machine. Your callers might record
a message with their fax. This is called a voice annotation.
NOTE
If your messaging system uses a third-party fax integration, you can also
deliver e-mail messages and meeting requests to a fax machine.

USING A PHONE
To Deliver a Fax
1 Press 1 to hear new messages, or press 3 to review old messages.
2 If your messaging system uses the ActiveFax integration, after you listen to any voice

annotation included with a fax, press 8.
NOTE
With a third-party fax integration, you can press
voice annotation included with a fax.

8 after you listen to any

3 Enter the fax phone number.
4 Use the following keys to manage your fax messages and to control message playback.

Use these keys during voice annotation
TASK

Repeat
Save
Delete
Change volume

KEY

1
2
3
5

TASK

KEY

Reverse

7
8
9

Pause or continue
Fast-forward to end

Use these keys after voice annotation
TASK

Repeat
Save
Delete
Return call
Reply to all
Reply to sender

KEY

1
2
3
41
44
#

TASK

KEY

Forward message

5
6
7
8
9

Mark as new
Reverse
Deliver an e-mail or fax to a fax
phone number
Hear summary

Use these keys anytime
TASK

Cancel or back up

UNIVERGE UM8500 USER GUIDE

KEY

*

TASK
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Checking E-mail
Messages in an
External Mailbox

If the text-to-speech feature is licensed and installed in your organization, you can check
messages using up to nine different external mailboxes. An external mailbox can be on another
e-mail system such as Lotus Notes or GroupWise, or you can check messages using an Internet
e-mail account. The messaging system administrator must enable this feature for your account.
Ask your e-mail system administrator to define external mailboxes for your account. You must
provide a mailbox name, server name, SMTP server name, a SMTP server address, user name,
and password for the external mailbox. Use the UM8500 Assistant to define information about
the external mailbox before you check messages in an external mailbox.
When the messaging system plays messages in an external mailbox, it plays voice messages
first, then fax messages, followed by e-mail messages. This order is fixed and cannot be
changed. The messaging system asks you to select which external mailbox to check.
Special delivery options, such as future delivery or urgent delivery, are not available for e-mail
messages left in an external mailbox. You cannot return a call to a person who left a message in
an external mailbox.

USING A PHONE
To Check E-mail Messages in an External Mailbox
1 Call the messaging system and log on.
2 Press 1 5 to check new messages in an external e-mail mailbox, or press 3 5 to check

old messages in an external e-mail mailbox.
3 If you have more than one external e-mail mailbox, follow the prompts to select the

external mailbox you want. The messaging system lists external mailboxes by name, in the
order defined using the UM8500 Assistant.
4 The messaging system reads the text of each message in the external mailbox.
5 Use the following keys to manage your messages and to control playback.

Use these keys during an external e-mail message
TASK

Repeat
Save
Delete
Change volume

KEY

1
2
3
5

TASK

KEY

Reverse

7
8
9

Pause or continue
Fast-forward to end

Use these keys after an external e-mail message
TASK

Repeat
Save
Delete
Forward message

KEY

1
2
3
5

TASK

KEY

Mark as new

6
7
8
9

Reverse
Deliver an e-mail or fax to a fax
phone number *
Hear summary

* Available only if you are using the fax option.

Use these keys anytime
TASK

Cancel or back up
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■ Sending Messages

You can send messages to subscribers, private lists, and public distribution lists. If your
organization has multiple locations, you might be able to send messages to subscribers at
another location.

In this Chapter...
Sending a Voice Message ........................................................................................ 32
Sending an Urgent Message .................................................................................... 34
Requesting a Return Receipt .................................................................................... 36
Sending a Private Message ...................................................................................... 38
Sending a Message with Future Delivery.................................................................... 40
Sending a Message with an Expiration Date ............................................................... 42
Sending a Priority Broadcast Message ....................................................................... 45
Sending a Priority Broadcast Message ....................................................................... 45
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Sending a Voice
Message

You can address messages by phone either in spelling mode or number mode.
Press # # to switch between spelling mode and number mode. You can address a message to
more than one recipient or type of recipient.
Spelling mode. On the phone keypad, spell the name of a subscriber, distribution list,
or (if available) another location.
Number mode. On the phone keypad, enter the number of an extension, distribution
list, or (if available) another location.

USING A PHONE
To Send a Voice Message
1 Call the messaging system and log on.
2 Press 2.
3 Follow the messaging system conversation to address the message.
4 Press # to record the message. After recording, press #.
5 Press # to send the message, or press 1 for message options.

USING E-MAIL
With Unified Messaging for Outlook to Send a Voice Message
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or File > New > Voice

Message or New > Voice Message.

3 Type recipient names and a subject.
4 On the Audio Control bar, click Record and speak into the microphone to record the

message.
5 When you finish recording, click Stop.
6 Add text and attachments, as appropriate.
7 Click Options... to mark a message as Importance, Sensitivity, Delivery receipt, specify a

Future delivery date, or Expiration date.
Importance
Sensitivity
Delivery
receipt
Future
delivery
Expires
after

8 Click Close to return to the message.
9 Click Send.
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USING E-MAIL
With ViewMail for Outlook to Send a Voice Message
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or Action > New Voice

Message.

3 Type recipient names and a subject.
4 On the Media Master control bar, click Record to record a message with your recording

device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
5 When you finish recording, click Stop.
6 Add text and attachments, as appropriate.
7 Click Options... to mark a message as Importance, Sensitivity, Delivery receipt, specify a

Future delivery date, or Expiration date.
Importance
Sensitivity
Delivery
receipt
Future
delivery
Expires
after

8 Click Close to return to the message.
9 Click Send.
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Sending an
Urgent Message

You can use special delivery to mark a message as urgent before you send it. An urgent message
is played first, before other messages.

USING A PHONE
To Send an Urgent Message
1 Call the messaging system and log on.
2 Press 2.
3 Follow the messaging system conversation to address the message.
4 Press # to record the message. After recording, press #.
5 Press 1 for message options.
6 Press 3 for special delivery.
7 To mark the message as urgent, press 1.
8 Sending the message, press #.

USING E-MAIL
With Unified Messaging for Outlook to Send an Urgent Message
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or File > New > Voice

Message or New > Voice Message.

3 Type recipient names and a subject.
4 On the Audio Control bar, click Record and speak into the microphone to record the

message.
5 When you finish recording, click Stop.
6 Add text and attachments as appropriate.
7 Click Options... and in the Importance field, select High.
8 Mark the other message options, Sensitivity, Delivery receipt, specify a Future delivery

date, or Expiration date, as needed.
9 Click Close to return to the message.
10 Click Send.

USING E-MAIL
With ViewMail for Outlook to Send an Urgent Message
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or Action > New Voice

Message.
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3 Type recipient names and a subject.
4 On the Media Master control bar, click Record to record a message with your recording

device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
5 When you finish recording, click Stop.
6 Add text and attachments as appropriate.
7 Click Options... and in the Importance field, select High.
8 Mark the other message options, Sensitivity, Delivery receipt, specify a Future delivery

date, or Expiration date, as needed.
9 Click Close to return to the message.
10 Click Send.
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Requesting a
Return Receipt

You can use special delivery to send a message with return receipt requested. the messaging
system sends a receipt to your mailbox when a message recipient listens to or opens the
message. For messages sent to a distribution list, the messaging system sends a receipt for each
recipient.

USING A PHONE
To Request a Return Receipt for a Message
1 Call the messaging system and log on.
2 Press 2.
3 Follow the messaging system conversation to address the message.
4 Press # to record the message. After recording, press #.
5 Press 1 for message options.
6 Press 3 for special delivery.
7 To mark the message for return receipt, press 2.
8 Sending the message, press #.

USING E-MAIL
With Unified Messaging for Outlook to Request a Return Receipt for
a Message
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or File > New > Voice

Message or New > Voice Message.

3 Type recipient names and a subject.
4 On the Audio Control bar, click Record and speak into the microphone to record the

message.
5 When you finish recording, click Stop.
6 Add text and attachments as appropriate.
7 Click Options... and select the Request a delivery receipt for this message

check box.
8 Mark the other message options, Importance, Sensitivity, specify a Future delivery date, or

Expiration date, as needed.
9 Click Close to return to the message.
10 Click Send.
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USING E-MAIL
With ViewMail for Outlook to Request a Return Receipt for a
Message
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or Action > New Voice

Message.

3 Type recipient names and a subject.
4 On the Media Master control bar, click Record to record a message with your recording

device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
5 When you finish recording, click Stop.
6 Add text and attachments as appropriate.
7 Click Options... and select the Request a delivery receipt for this message

check box.
8 Mark the other message options, Importance, Sensitivity, specify a Future delivery date, or

Expiration date, as needed.
9 Click Close to return to the message.
10 Click Send.
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Sending a Private
Message

You can use special delivery to send a private message. A private message cannot be forwarded.

USING A PHONE
To Send a Private Message
1 Call the messaging system and log on.
2 Press 2.
3 Follow the messaging system conversation to address the message.
4 Press # to record the message. After recording, press #.
5 Press 1 for message options.
6 Press 3 for special delivery.
7 To mark the message private, press 3.
8 Sending the message, press #.

USING E-MAIL
With Unified Messaging for Outlook to Send a Private Message
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or File > New > Voice

Message or New > Voice Message.

3 On the Audio Control bar, click Record and speak into the microphone to record the

message.
4 When you finish recording, click Stop.
5 Add text and attachments as appropriate.
6 Click Options... and in the Sensitivity field, select Private.
7 Mark the other message options, Importance, Delivery receipt, specify a Future delivery

date, or Expiration date, as needed.
8 Click Close to return to the message.
9 Click Send.

USING E-MAIL
With ViewMail for Outlook to Send a Private Message
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or Action > New Voice

Message.

3 Type recipient names and a subject.
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4 On the Media Master control bar, click Record to record a message with your recording

device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
5 When you finish recording, click Stop.
6 Add text and attachments as appropriate.
7 Click Options... and in the Sensitivity field, select Private.
8 Mark the other message options, Importance, Delivery receipt, specify a Future delivery

date, or Expiration date, as needed.
9 Click Close to return to the message.
10 Click Send.
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Sending a
Message with
Future Delivery

You can use special delivery to mark a message to be sent at a later time. the messaging system
does not send the message to any recipients until the specified date. You can also mark a
message for future delivery with Microsoft Outlook. See online Help for details.

USING A PHONE
To Send a Message with Future Delivery
1 Call the messaging system and log on.
2 Press 2.
3 Follow the messaging system conversation to address the message.
4 Press # to record the message. After recording, press #.
5 Press 1 for message options.
6 Press 3 for special delivery.
7 To mark the message for future delivery, press 4.
8 Sending the message later today, press 0. For tomorrow, press 1. For two days later, press

2; or to enter a date, press 9. Enter the month, using a number from 1 to 12. Enter the date,
using a number from 1 to 31.
9 Enter the time, including the hour and minutes. For A.M., press 1. For P. M., press 2.
10 To confirm the delivery time and date, press #.
11 Sending the message, press #.

USING E-MAIL
With Unified Messaging for Outlook to Send a Message with Future
Delivery
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or File > New > Voice

Message or New > Voice Message.

3 Type recipient names and a subject.
4 On the Audio Control bar, click Record and speak into the microphone to record the

message.
5 When you finish recording, click Stop.
6 Add text and attachments as appropriate.
7 Click Options..., select the Do not deliver before: check box and then select a date

and time for delivery.
8 Mark the other message options, Importance, Sensitivity, Delivery receipt, or Expiration

date, as needed.
9 Click Close to return to the message.
10 Click Send.
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USING E-MAIL
With ViewMail for Outlook to Send a Message with Future Delivery
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or Action > New Voice

Message.

3 Type recipient names and a subject.
4 On the Media Master control bar, click Record to record a message with your recording

device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
5 When you finish recording, click Stop.
6 Add text and attachments as appropriate.
7 Click Options..., select the Do not deliver before: check box and then select a date

and time for delivery.
8 Mark the other message options, Importance, Sensitivity, Delivery receipt, or Expiration

date, as needed.
9 Click Close to return to the message.
10 Click Send.
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Sending a
Message with an
Expiration Date

You can use special delivery to mark a message to be sent with an expiration date and time. the
messaging system keeps an unheard message in a recipient’s mailbox until the expiration time
and date. Then, the messaging system deletes the message.
You can send a message with an expiration date to another subscriber, or to a distribution list.
You can set an expiration date and time by phone. Setting an expiration time and date is useful
when the content of a message is relevant only until a certain time and date.

USING A PHONE
To Send a Message with an Expiration Date
1 Call the messaging system and log on.
2 Press 2.
3 Follow the messaging system conversation to address the message.
4 Press # to record the message. After recording, press #.
5 Press 1 for message options.
6 Press 3 for special delivery.
7 To mark the message with an expiration time and date, press 5.
8 For expiration later today, press 0. For tomorrow, press 1. For two days later, press 2; or

to enter a date, press 9. Press the month, using a number from 1 to 12. Press the date,
using a number from 1 to 31.
9 Enter the expiration time, including the hour and minutes. For A.M., press 1. For P. M.,

press 2.
10 To confirm the expiration time and date, press #.
11 Sending the message, press #.

USING E-MAIL
With Unified Messaging for Outlook to Send a Message with an
Expiration Date
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or File > New > Voice

Message or New > Voice Message.

3 Type recipient names and a subject.
4 On the Audio Control bar, click Record and speak into the microphone to record the

message.
5 When you finish recording, click Stop.
6 Add text and attachments as appropriate.
7 Click Options..., select the Expires after: check box and then select a date and time for

the message expiration.
8 Mark the other message options, Importance, Sensitivity, Delivery receipt, or Future

delivery date, as needed.
9 Click Close to return to the message.
10 Click Send.
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USING E-MAIL
With ViewMail for Outlook to Send a Message with an Expiration
Date
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 Open your Outlook Inbox.
2 On the Outlook toolbar, click New Voice Message or Action > New Voice

Message.

3 Type recipient names and a subject.
4 On the Media Master control bar, click Record to record a message with your recording

device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
5 When you finish recording, click Stop.
6 Add text and attachments as appropriate.
7 Click Options..., select the Expires after: check box and then select a date and time for

the message expiration.
8 Mark the other message options, Importance, Sensitivity, Delivery receipt, or Future

delivery date, as needed.
9 Click Close to return to the message.
10 Click Send.
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Sending a
Message to a List
of Recipients

Private lists and public distribution lists are lists of message recipients that are grouped
together. A message sent to a distribution list goes to every recipient on the list. A distribution
list makes it easier to send a message to several people at once.
Any subscriber can send messages to public distribution lists by phone. You can address a
message to a public distribution list using spelling mode or number mode.
Only you can send messages to your private lists. You address messages to private lists only by
phone. You can address a message to a private list using spelling mode or number mode.
For public distribution lists, your system administrator might have authorized you to send
priority broadcast messages. See “Sending a Priority Broadcast Message” on page 45.

USING A PHONE
To Send a Message to a List of Recipients
1 Call the messaging system and log on.
2 Press 2.
3 If desired, switch between number mode and spelling mode by pressing # #.
4 Spell the distribution list name, or enter the number of the list. Private lists are numbered 1

through 20. Press # to confirm the name or number.
5 Press # to record the message. After recording, press #. Press # to send the message, or

press 1 for message options.
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Sending a Priority
Broadcast
Message

You can send a priority broadcast message to a public distribution list. A priority broadcast
message is played, immediately when a recipient logs on, before the messaging system offers
any other options or messages. A recipient must hear the entire message before the messaging
system marks the message as read.
Your system administrator can set you up to send priority broadcast messages to a particular
distribution list. If you are authorized, a new option plays in the subscriber main menu:
Sending a priority broadcast message, press 6.
If desired, you can prevent recipients from skipping or fast-forwarding through a message. After
you record a priority broadcast message, you can set a special delivery option requiring
recipients to listen to the entire message.
If you require recipients to hear the message, a recipient cannot skip the message or fastforward through it. The recipient cannot use other UNIVERGE UM8500 features by phone until
the entire message is played. Each time a recipient calls to check messages, the messaging
system plays the message immediately and keeps it new until the entire message is played.
If you do not prevent recipients from skipping or fast-forwarding the message, a recipient must
still listen to the entire message before it is marked as old. However, a recipient can skip the
message and use other UM8500 features by phone before hearing the entire message.
A recipient of a priority broadcast message cannot forward the message by phone to other
subscribers.
You can send priority broadcast messages only by phone. A priority broadcast message is
always marked as urgent and private.
In Outlook, priority broadcast messages are listed as urgent messages. The subject line for the
message begins with Priority Broadcast.

USING A PHONE
To Send a Priority Broadcast Message
1 Call the messaging system and log on.
2 Press 6 to send a priority broadcast message.
3 Switch between number mode and spelling mode by pressing # #.
4 Follow the messaging system conversation to address the message to a public distribution

list.
5 Press # to record the message, press # to end the message.
6 Press 1 for message options.
7 Press 3 for special delivery.
8 Press 9, to require recipients to play the entire message.
9 Press # to send the message.
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Sending a
Message to
another Location

Send messages by phone to subscribers at other locations, you must identify the location as
well as the subscriber when addressing the message. Contact your system administrator for
locations and other subscribers.

USING A PHONE
To Send a Message to another Location
1 Call the messaging system and log on.
2 Press 2.
3 Record the message, press # to end the message.
4 If addressing in spelling mode, spell the location name, then spell the subscriber name, or

In number mode, enter the location ID, then enter the subscriber extension.
If addressing in number mode, enter the location ID, then enter the subscriber extension.
5 Press # to record the message, press # to end the message.
6 Press # to send the message, or press 1 for message options.
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■ Recording Phone Calls

Depending on the phone system your organization uses, you might be able to record phone
calls while you are talking.
The messaging system stores received phone calls and recorded phone calls as voice messages.
You can record phone calls only if your phone has a Record key. You handle recorded call
messages the same way you handle other voice messages.
When you check messages by phone, the messaging system plays recorded call messages along
with your other voice messages. Your name is listed as the sender.
When you check messages from your Inbox, recorded call messages look like other voice
messages. Your name is listed in the To and From boxes, and Live Record message is listed in the
Subject box.

In this Chapter...
Recording a Phone Call ........................................................................................... 48
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Recording a Phone Call
USING A PHONE
To Record a Phone Call
❚

Press the Record key on the phone during the phone call.
NOTE
The use of monitoring, recording or listening devices to eavesdrop,
monitor, retrieve, or record phone conversations or other sound
activities—whether or not contemporaneous with transmission—might be
illegal in certain circumstances under local laws. Legal advice should be
sought prior to implementing any practice that monitors or records any
phone conversation. Some laws require some form of notification to all
parties to a phone conversation—such as using a beep tone or
other notification method, or requiring the consent of all parties to the
phone conversation—prior to monitoring or recording the phone
conversation. Some of these laws incorporate strict penalties.
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■ Changing Personal Settings

Personal settings control the information about you as a subscriber on the messaging system
and some of the choices you make for interacting with the messaging system.
Recorded name. Plays your recorded name with messages left for other subscribers
and identifies you in directory assistance. It also plays with any of your greetings that use
system default recordings instead of your own recordings.
Password. Passwords protect the privacy of messages. If you forget the messaging
system phone password, your system administrator can create a temporary password.
Change the password the next time you log on.
Fax delivery number. The number of the fax machine where your faxes are normally
sent to.
Directory listing status. When you are listed in the directory, callers can reach you
through directory assistance.
Conversation language. When your organization has more than one language
installed on the messaging system, select the language you hear in the messaging system
conversation. The system administrator sets the language callers hear.
Text-to-speech language. Select the language in which the messaging system plays
e-mail messages and calendar entries. The text-to-speech language can be different from
the language heard in the messaging system conversation.
Conversation menus. Hear full or brief menus when you interact with the messaging
system by phone. Full menus provide comprehensive instructions, and brief menus
provide abbreviated versions of full menus.

In this Chapter...
Changing your Recorded Name ................................................................................ 50
Changing your Directory Listing ............................................................................... 51
Changing your Phone Password................................................................................ 52
Changing the Fax Delivery Number ........................................................................... 53
Changing the Conversation Language ....................................................................... 54
Changing the Text-to-Speech Settings....................................................................... 55
Switching between Full or Brief Conversation Menus ................................................... 56
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Changing your
Recorded Name

The messaging system plays your recorded name when callers find your extension in directory
assistance, and when you use a phone to log on to the messaging system.

USING A PHONE
To Change your Recorded Name
1 Call the messaging system and log on.
2 Press 4 > 3 > 2.
3 At the tone, record your name, or press * to keep the current recording.

Use these keys as you record
TASK

KEY

Pause or continue

5

TASK

KEY

End recording

#

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Change your Recorded Name
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Personal Settings, click Name.
Save
Navigation pane

Record
Stop

Text-tospeech
option
3 Use the Audio Control bar, click Record to record your name with the selected recording

device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
4 Click Stop to end the recording.
5 Click Save to save the new recording.
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Changing your
Directory Listing

Set whether or not you are listed in the messaging system directory. When you are listed in the
directory, callers can find your extension number without assistance from a receptionist.

USING A PHONE
To Change your Directory Listing
1 Call the messaging system and log on.
2 Press 4 > 3 > 3.
3 Set whether or not you are listed in the messaging system directory. When you are listed in

the directory, callers can find your extension number without assistance from a
receptionist. Press 1 to change your listing status, or press # to keep your current listing
status.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Change your Directory Listing
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Personal Settings, click Directory Listing.
Save

Navigation pane

Listing
status

3 Select the List in phone directory check box to be listed in the directory. Clear the

check box to remove your name from the directory.
4 Click Save to save the changes.
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Changing your
Phone Password

Enter your messaging system phone password when using a phone to log on to the messaging
system. The password used to log on with the phone is different from the password used to
access the UM8500 Assistant. Use the following procedures to change your passwords.

USING A PHONE
To Change your Password
1 Call the messaging system and log on.
2 Press 4 > 3 > 1.
3 Enter a new password, then press #.
4 Enter the new password once again to confirm it, then press #.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Change your Password
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Personal Settings, click Phone Password.

The Personal Settings page appears.
Save

Navigation pane

Phone
password
fields

3 In the Enter new password box, type a password.
4 In the Confirm new password box, type the password again.
5 Click Save to save the new password.
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Changing the Fax
Delivery Number

The fax delivery number is the number of the fax machine where your faxes are normally sent
to. When using a phone to access fax messages, the messaging system provides the option to
deliver the fax to this phone number.
You can use your fax delivery number only with the UM8500 Assistant, not by phone.
NOTE
This option is only available if you are licensed to use ActiveFax.

USING THE UM8500 ASSISTANT
To Change the Fax Delivery Number
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Personal Settings, click Faxes.

The Personal Settings page appears.
Save

Navigation pane

Fax delivery number
3 In the Fax delivery number box, type the fax delivery number.

Do not use spaces, dashes, or parentheses between digits. Begin with any access code
needed to make an external call (for example, 9). For long distance numbers, also include 1
and the area code.
4 Click Save to save the new fax delivery number.
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Changing the Conversation Language
You can select a conversation language only with the UM8500 Assistant, not by phone.

USING THE UM8500 ASSISTANT
To Change the Conversation Language
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Personal Settings, click Language.

The Personal Settings page appears.
Save

Navigation pane

Language options
3 In the My Language list, select the language to use in the messaging system

conversation.
4 Click Save to save the language settings
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Changing the
Text-to-Speech
Settings

You can set the language in which the messaging system reads your e-mail messages by phone.
The language you select for your e-mail can be different from the language you use for the
system conversation.
You can also set whether the messaging system automatically detects the language used for an
e-mail message. If the messaging system cannot detect the language in which to read an e-mail
message, the messaging system uses the default text-to-speech language.
You can select a text-to-speech language only in the UM8500 Assistant, not by phone.

USING THE UM8500 ASSISTANT
To Change the Text-to-Speech Settings
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Personal Settings, click Language.

The Personal Settings page appears.
Save

Navigation pane

Language options
3 In the My Text-To-Speech language list, select the language used to play e-mail

messages and calendar schedule.
4 The messaging system automatically determines which language to use for e-mail

messages and calendar items if Use Auto-Detect is selected.

5 Click Save to save the Text-To-Speech setting.
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Switching between Full or Brief Conversation Menus
You can set whether you hear comprehensive or brief instructions for menu options when you
access the messaging system by phone.
Most new subscribers begin with the comprehensive instructions. Once you are familiar with
the messaging system features, you can switch from full menus to brief menus.

USING A PHONE
To Switch between Full and Brief Conversation Menus
1 Call the messaging system and log on.
2 Press 4 > 2 > 3.
3 Press 1 to switch between full and brief menus.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Switch between Full and Brief Conversation Menus
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Message Playback.

The Message Playback page appears.

Save

Navigation pane
Menu
Selections

3 In the Playback options, Menu type section, select Full menus or Brief menus.

Full menus. The messaging system plays comprehensive instructions.
Brief menus. The messaging system plays abbreviated version of instructions.
4 Click Save.
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■ Changing Recording and Playback
Settings

Recording and playback settings control how greetings and names are recorded and played and
how messages are recorded and played in the e-mail Inbox.
Select recording and playback devices using the procedures described in this chapter. The
available devices depends upon how the computer is set up.
Recording devices. Speak into a phone or a multimedia microphone, if one is
attached to the computer.
Playback devices. Listen to messages or recordings using a phone, or speakers
attached to the computer.
A playback volume control setting is available for the phone. Also, for Unified Messaging for
Outlook there are options for setting automatic playback, changing the sounds for new and
urgent messages, and how voice messages your send are retained.

In this Chapter...
Change Recording and Playback Devices ................................................................... 58
Changing the Playback Volume ................................................................................ 60
Changing the Recording Format for Non-Phone Devices ............................................... 61
Changing Unified Messaging for Outlook Options ........................................................ 63
Changing ViewMail for Outlook Options ..................................................................... 64
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Change
Recording and
Playback Devices

Select the phone or a multimedia microphone to record messages. The phone and multimedia
speakers can be used to play messages. The devices can be selected in:
●

UM8500 Assistant

●

If your messaging system uses Unified Messaging for Outlook, using the Unified Messaging
for Outlook Options

●

If your messaging system uses ViewMail for Outlook, using the ViewMail for Outlook
Options

USING THE UM8500 ASSISTANT
To Select Recording and Playback Devices
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.

The Greetings page appears.
3 On the Greetings page, click Options Menu > Playback Devices or Recording

Devices to select the playback or recording devices.
Options
Menu

Device
list
Playback and
Recording Devices
Options

4 Select a device.

Tip

Use a phone as the recording device to get the best sound quality.

5 If you selected Phone as a playback or recording device, click the Options menu, then

select Options.

The Phone Record and Playback Settings dialog box appears.

Type your extension and the name of your server. If you do not know your server name,
contact your system administrator.
6 If you selected a recording device other than Phone and you have Unified Messaging for

Outlook installed, you can specify the recording format for the device. See “Changing the
Recording Format for Non-Phone Devices” on page 61.
7 Click OK, then click the Save icon to save your changes.
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USING E-MAIL
To Select Recording and Playback Devices Using Unified Messaging
for Outlook Options
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 Click the Tools > Options, the Options dialog box appears.

Click the Unified Messaging for Outlook tab.
2 Click Voice Options. The Voice Message Options dialog box appears.
3 Select the following:

Playback Device. Select the device used for playing a voice message. The list
automatically displays media devices installed on the computer.
Recording Device. Select the device for recording a voice message. The list
automatically displays media devices installed on the computer.
For information about selecting the appropriate playback or recording device, contact your
system administrator.
4 Click OK to save any changes.

USING E-MAIL
To Select Recording and Playback Devices Using ViewMail for
Outlook Options
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 Click the Tools menu, then select ViewMail Options.

The ViewMail Options dialog box appears.
2 Click the Record or Playback tab.
3 In the Device list, select one of the following:

Phone. To record and play messages on the phone.
Multimedia device. A device installed on the computer. The list automatically displays
media devices installed on the computer.
For information about selecting the appropriate driver, contact your system administrator.

Tip

Use a phone as the recording device to get the best sound quality.

4 If you selected Phone, click the General tab.
■
■

In the Extension field, type your extension.
In the Server field, type the name of the messaging system server. The system
administrator can provide the server name.

5 Click OK to save any changes.
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Changing the
Playback Volume

Adjust the volume of message playback as you listen to a message by phone. Any adjustments
made by phone does not affect the playback volume of other messages.
Adjust the volume for all messages in the UM8500 Assistant.
Adjusting the recording volume or the playback volume of greetings is not permitted.
NOTE
This feature may not be available on your system.

USING A PHONE
To Change the Playback Volume
❚

While listening to a message, press 5 to toggle between the following volume settings:
Press once. Increases the volume.
Press again. Decreases the volume.
Press again. Returns the volume to the default.

USING THE UM8500 ASSISTANT
To Change the Playback Volume
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Message Playback.
Save
Navigation pane

Volume
options

3 In the Volume Level section, click Low, Medium, or High.
4 Click the Save icon to save your changes.
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Changing the Recording Format for Non-Phone Devices
You can specify the recording format for a non-phone device if you have Unified Messaging for
Outlook or ViewMail for Outlook installed.

USING E-MAIL
To Change the Recording Format for Non-Phone Devices with
Unified Messaging for Outlook
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 Click the Tools > Options, the Options dialog box appears.

Click the Unified Messaging for Outlook tab.
2 Click Voice Options. The Voice Message Options dialog box appears.
3 Select the Recording Codec that will be used.
NOTE
Your system administrator can provide you with the list of recording formats
supported by your messaging system.
4 Click OK to save any changes.
WARNING!
There might be situations where the format selected is installed on your
desktop computer and is supported by the messaging system, but is not
installed on the messaging system. In this case, subscribers that receive the
voice messages you recorded will not be able to listen to the message because
the messaging system does not have the format you used for recording the
message installed.
To avoid this situation, be sure to select a format that is supported by your
messaging system.

USING E-MAIL
To Change the Recording Format for Non-Phone Devices with
ViewMail for Outlook
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 Click the Tools menu, then select ViewMail Options.

The ViewMail Options dialog box appears.
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2 Click the Record tab.

3 In the Device list, select SoundMax Digital Audio, and then click Select.

The Choose Record Format dialog box appears.

4 Select the recording format you want to use by:
■

Select a saved format from the Name list.
OR

■

Select a format from the Format list and select the attributes from the Attribute list.
The Format list shows the formats supported by the system. Select the format you
want to use when recording voice messages using non-phone devices.
The Attributes list shows the attributes corresponding to the selected format. Select
the attributes for the format.

NOTE
Your system administrator can provide you with the list of recording
formats supported by your messaging system.
5 Click OK to save any changes. ViewMail for Outlook will verify if the selected format is

supported by the messaging system. If the selected format is not supported by the system,
a warning message appears and your changes are not saved.
WARNING
There might be situations where the format selected is installed on your
desktop computer and is supported by the messaging system, but is not
installed on the messaging system. In this case, subscribers that receive
the voice messages you recorded will not be able to listen to the message
because the messaging system does not have the format you used for
recording the message installed.
To avoid this situation, be sure to select a format that is installed on your
messaging system.
6 Optionally, click Save as to save the selected format.

The Save as dialog box appears.
Type a Name for the format, then click OK.
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Changing Unified Messaging for Outlook Options
When automatic playback is turned on, your voice messages begin playing as soon as you open
a message from your Inbox. Use the Audio Control bar to play voice messages if automatic
playback is turned off.

USING E-MAIL
To Change Unified Messaging for Outlook Options
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.
1 Click the Tools > Options, the Options dialog box appears.

Click the Unified Messaging for Outlook tab.
2 Select or clear the option check boxes:
●

Play message automatically. When selected, this option automatically plays a
voice message when you open a new message from your Outlook Inbox.
NOTE
Voice messages are automatically played only if they are new unread
messages.

●

●

●

Play urgent message sound. When selected, a sound is played every time you
receive an urgent voice message. Click the speaker button to hear the sound for an
urgent message. Click the browse button to specify the sound used for an urgent
message.
Play new message sound. When selected, a sound is played every time you
receive a new voice message. Click the speaker button to hear the sound for a new
message. Click the browse button to specify the sound used for a new message.
Keep only message header in the Sent items folder. When selected, for
any voice message sent using Unified Messaging for Outlook only the message header
(not the entire message with the attached voice message) is kept in the Sent Items
folder.

3 Click OK.
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Changing ViewMail for Outlook Options
When automatic playback is turned on, your voice messages begin playing as soon as you open
a message from your Inbox. Use the Audio Control bar to play voice messages if automatic
playback is turned off.

USING E-MAIL
To Change ViewMail for Outlook Options
NOTE
This procedure only applies if you have ViewMail for Outlook installed. If you
do not know if this option installed, contact your system administrator.
1 Click the Tools > Options, the Options dialog box appears. Click the ViewMail for

Outlook tab.

2 Select or clear the option check boxes:
●

●

Play message automatically. When selected, this option automatically plays a
voice message when you open a new message from you Outlook Inbox.
Keep only message header in the Sent items folder. When selected, for
any voice message sent using ViewMail for Outlook only the message header (not the
entire message with the attached voice message) is kept in the Sent Items folder.

3 Click OK.
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■ Changing Greeting Settings

Greetings are used to provide callers with information and instructions when you are not able
to take calls. The messaging system plays your greetings in the appropriate situations,
depending on the organization business hours and the currently selected greeting.
The greetings feature provides you with the flexibility to customize your greetings to suit your
needs. You can use the default greetings that are shipped with the system or re-record them.
You can also create your own individual greetings using the phone or from the UM8500
Assistant. In addition, the system administrator can create additional greetings for your use.
If you are using the FindMe FollowMe feature, the messaging system evaluates your scenarios
and plays the greeting of the FollowMe policy associated with the current scenario.
If you are not using the FindMe FollowMe feature, the messaging system plays the greeting set
as your current greeting.

In this Chapter...
System Greetings................................................................................................... 66
Adding a Greeting .................................................................................................. 67
Recording Greetings ............................................................................................... 68
Setting your Current Greeting .................................................................................. 70
Enabling or Disabling Special Greetings ..................................................................... 72
Changing a Greeting Recorded Name ........................................................................ 73
Changing a Greeting Spelled Name........................................................................... 75
Changing a Greeting Source .................................................................................... 76
Allowing Callers to bypass your Greeting ................................................................... 77
Deleting a Greeting ................................................................................................ 78
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System Greetings

There are seven default greetings that ship with the messaging system:
Standard. This greeting plays during work hours. The standard greeting plays unless it is
overridden by another greeting.
Closed. This greeting plays during nonworking hours. The closed greeting overrides the
standard greeting during nonbusiness hours.
Internal. This greeting plays only to callers within your organization. It can provide
information that coworkers need to know. If this special greeting is enabled, it overrides the
standard and closed greetings when you do not answer your phone.
Busy. This greeting plays when you are on the phone. The busy greeting overrides the
standard, closed, and internal greetings.
Alternate. This greeting plays to indicate special circumstances, such as when you are
on vacation. If this greeting is set as your current greeting it overrides all other greetings.
Unavailable. This greeting is used when your calendar shows you are in a meeting or
otherwise unavailable.
Out-of-Office. This greeting is used when your calendar shows you are out of office.
You should record a Standard greeting, but you can use the default recordings for other system
greetings. You can record your own greeting for any system greeting. You can enable or disable
the greetings using the phone or the UM8500 Assistant.
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Adding a Greeting

You can add a greeting using the phone or the UM8500 Assistant.

USING A PHONE
To Add a Greeting
1 Call the messaging system and log on.
2 Press 4 > 1 > 1 > 3 > 8 > 3.
3 At the tone, record the name of the greeting.
4 Press 1 to confirm the recorded name or 2 to re-record it.
5 Use the phone keys to give the new greeting a spelled name by entering the first three letter

of the greeting's name.
6 Press 1 to confirm the spelled name or 2 to change it.
7 The new greeting is added. To record the greeting, see “Recording Greetings” on page 68.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Add a Greeting
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.
Save

Navigation pane

Add new
greeting

3 Click Add new greeting.
4 In the Add a greeting dialog box, type the name of the greeting.
5 Click Add, the new greeting is added.

To record the greeting, see “Recording Greetings” on page 68.
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Recording
Greetings

You can record your own version of system greetings or personal greetings using the phone or
the UM8500 Assistant.
If applicable, you can also record a greeting for a shared phone, see “Recording Greetings for a
Shared Phone” on page 138.

USING A PHONE
To Record a Greeting
1 Call the messaging system and log on.
2 Press 4 > 1 > 1.
3 After the messaging system plays your current greeting, press 1 to rerecord it, or press 3

to select and rerecord a different greeting.
If you pressed 3 to edit other greetings, select the greeting by pressing the corresponding
menu key, then press 2 to rerecord-it.
GREETING

KEY

Standard

1
3
5
7

Alternate
Internal
Unavailable

GREETING

KEY

Closed

2
4
6
8

Busy
Out-of-Office
other

Use these keys as you record
TASK

KEY

Pause or continue

8

TASK

KEY

End recording

#

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Record a Greeting
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.
Save

Navigation pane

Greeting
list

Record
Stop

3 On the Greetings page, select a greeting to record from the Greeting drop-down list.
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4 Under Source, click Recording.
5 On the Audio Control bar, click Record and record the greeting using the selected

recording device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
6 When you finish recording, click Stop.
7 Click Save to save the recording
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Setting your Current Greeting
You can set the greeting used as your the current greeting.
If you are using the FindMe FollowMe, this setting does not apply. Instead, the messaging
system plays the current FollowMe policy greeting.

USING A PHONE
To Set the Current Greeting
1 Call the messaging system and log on.
2 Press 4 > 1 > 1.
3 After the messaging system plays your current greeting, press 2 to turn on/off the

Alternate greeting or press 3 to set another greeting as current.
If you pressed 3, select the greeting by pressing the corresponding menu key, then press 3
to set the greeting as your current greeting.
GREETING

KEY

Standard

1
3
5
7

Alternate
Internal
Unavailable

GREETING

KEY

Closed

2
4
6
8

Busy
Out-of-Office
other

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Set the Current Greeting
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.
Save

Navigation pane

Greeting
list
Current
greeting
selection

3 In the Greeting list, select the greeting you want to set as current.
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4 Select the Make this my current greeting check box.
NOTE
When your alternate greeting is set as the current greeting, it overrides all
other greetings, including special greetings.
5 Click Save to save your current greeting change.
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Enabling or
Disabling Special
Greetings

The special greetings are the Busy, Internal, and Closed greeting. If you enable them, they will
override your current greeting, except for the Alternate greeting, in special conditions.
You can enable or disable special greetings in the UM8500 Assistant. They cannot be enabled
using the phone.

USING THE UM8500 ASSISTANT
To Enable or Disable a Special Greeting
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.
Save

Navigation pane

Greeting
list
Enable
special
greeting

3 In the Greeting list, select the Busy, Internal, or Closed greeting.
4 Select Enable this special greeting to make the special greeting available to the

messaging system, or clear the check box to make it unavailable to the messaging system.
NOTE
When your alternate greeting is enabled, it overrides all other greetings.
5 Click Save to save the special greeting changes.
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Changing a
Greeting
Recorded Name

A greeting must have a recorded name so that you can access the greeting.
You can record a greeting's name by phone or using the UM8500 Assistant.
NOTE
You cannot change the recorded name of the system greetings shipped with
the messaging system.

USING A PHONE
To Change a Greeting’s Recorded Name
1 Call the messaging system and log on.
2 Press 4 > 1 > 1 > 3 > 8 > 5.
3 At the tone, record the name of the greeting.
4 Press 1 to confirm the recorded name or 2 to re-record it.

Use these keys as you record
TASK

KEY

Pause or continue

8

TASK

KEY

End recording

#

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Change a Greeting’s Recorded Name
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.
Save

Navigation pane

Greeting
list

Record
Stop

3 In the Greeting list, select the greeting for which you are changing the recorded name.
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4 On the Audio Control bar, click Record and record the greeting name using the selected

recording device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
5 When you finish recording, click Stop.
6 Click Save to save the greeting name.
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Changing a
Greeting Spelled
Name

A greeting must have a spelled name associated with it so that you may access it.
You can enter greeting spelled name by phone or using the phone or the UM8500 Assistant.
NOTE
You cannot change the spelled name of the system greetings shipped with the
messaging system.

USING A PHONE
To Change a Greeting Spelled Name
1 Call the messaging system and log on.
2 Press 4 > 1 > 1 > 3 > 8 > 4.
3 Use the phone keys to change the greeting spelled name by entering the first three letter of

the greeting name.
4 Press 1 to confirm the spelled name or 2 to change it.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Change a Greeting Spelled Name
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.
Save

Navigation pane

Greeting
list
Rename
greeting

3 In the Greeting list, select the greeting for which you are changing the spelled name.
4 Click Rename, the Edit greeting description dialog box appears.
5 Type the new name for the greeting.
6 Click OK to save the greeting’s name.
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Changing a
Greeting Source

The greeting source sets what a caller hears when they reach a greeting.
You can change the source of system greetings and personal greetings using the UM8500
Assistant.

USING THE UM8500 ASSISTANT
To Change a Greeting Source
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.
Navigation pane

Save

Greeting
list

Source

3 In the Greeting list, select the greeting whose source you want to change.
4 Select a source:

System. The messaging system plays a prerecorded greeting along with your recorded
name, for example, Sorry, <your name> is not available.
Recording. The messaging system plays your recording.
Blank. The messaging system plays no greeting.
5 Click Save to save your changes.
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Allowing Callers
to bypass your
Greeting

Callers can normally press # to skip your greeting and immediately leave you a message.
There are situations, such as when you are on vacation or out of the office for an extended
period, when you want callers to listen to the entire greeting before leaving a message.
You can select whether or not to let callers skip your greeting by enabling or disabling the
Bypass Greeting setting.
NOTE
If FindMe FollowMe is enabled, the messaging system uses the bypass greeting
setting defined in the current FollowMe policy.

USING A PHONE
To Enable or Disable Greeting Bypass
1 Call the messaging system and log on.
2 Press 4 > 1 > 1.
3 After the messaging system plays your greeting, press 5 to enable or disable the Bypass

Greeting option.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Enable or Disable Greeting Bypass
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.
Save

Navigation pane

Greeting
list

Callers can
bypass the
greeting.
3 In the Greeting list, select the current greeting.
4 To let callers skip this greeting, select Allow callers to bypass greeting, or to require

callers to listen to this greeting, clear the Allow callers to bypass greeting check
box.
NOTE
This setting applies to all of your greetings.

5 Click Save to save your changes.

UNIVERGE UM8500 USER GUIDE

CHANGING GREETING SETTINGS

77

Deleting a
Greeting

You can delete a greeting using the phone or the UM8500 Assistant.
NOTE
You cannot delete system greetings shipped with the messaging system.

USING A PHONE
To Delete a Greeting
1 Call the messaging system and log on.
2 Press 4 > 1 > 1 > 3 > 8 > 2.
3 Use the phone keys to enter the first three letters of the greeting name you want to delete.
4 Press 6 to delete the greeting.
5 Press 1 to confirm the deletion or 2 to cancel it.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Delete a Greeting
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Greetings.
Save

Navigation pane

Greeting
list
Delete
greeting

3 In the Greeting list, select the greeting you want to delete.
4 Click Delete, the system asks to you confirm that you want to delete the greeting.
5 Click OK to delete the greeting or Cancel to cancel the deletion.
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■ Changing Call Settings

Call settings control some caller options and how the messaging system handles incoming
external calls:
Answer options. The messaging system can announce who the call is for when you
answer the phone. When the messaging system connects the call, you can take the call or
route it to a greeting for the caller to leave a message.
Call screening. With call screening on, the messaging system records a caller’s name
and plays it for you before connecting the call.
Busy/hold options. When your phone is busy, the messaging system has two hold
options or it can route callers to your greeting to leave a message.
Call transfer. You can answer your calls or have them routed to your greeting.
Generally, call transfer is set to ring a phone—either your extension or another phone—
when you are available to answer calls. You might transfer calls directly to your greeting
when you plan to be out of the office for an extended period. When you route calls to your
greeting, callers do not have to wait while your phone rings unanswered.
Caller message options. You can select whether callers can edit their messages and
mark them as urgent.
NOTE
If you are using the FindMe FollowMe feature, these settings do not take
effect. Instead, the messaging system uses the settings in the current
FollowMe policy.

In this Chapter...
Changing your Answer Options ................................................................................ 80
Changing Call Screening Options .............................................................................. 81
Changing Call Handling when your phone is busy ....................................................... 82
Changing Call Transfer Settings................................................................................ 83
Changing Caller Message Options ............................................................................. 85
Redirecting Calls to the Number you are calling from .................................................. 86
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Changing your
Answer Options

The type of call transfer used by the messaging system determines if these options are available.
See your system administrator for more information.

USING THE UM8500 ASSISTANT
To Change your Answer Options
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Call Transfer and Screening.
Save

Navigation pane

Answer
options

3 Select what the messaging system does when you answer the phone:

Tell me who... The messaging system plays the recorded name associated with the
dialed extension. Use this setting when two or more people share a phone.
Announce before connecting... The messaging system tells you when it connects the
call.
Confirm (accept call by pressing 1, or refuse by pressing 2). You can
accept or refuse an external call by pressing a key on the touchtone pad. If you press 1, the
caller is transferred to your phone. If you press 2, or perform no action, the call is refused
and the messaging system plays the appropriate greeting to the caller.
Confirm (accept call by pressing 1, or refuse by hanging up). You can
accept or refuse an external call by pressing 1 on the touchtone pad or by hanging up. If
you press 1, the caller is then transferred to your phone. If you hang up, the call is refused
and the messaging system plays the appropriate greeting to the caller.
4 Click Save to save your changes.
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Changing Call
Screening
Options

The messaging system screens calls by asking for and recording a caller’s name, then placing the
caller on hold. The messaging system rings your phone and announces the caller’s name.
Whether call screening is available depends on how the messaging system is set up at your
organization. See your system administrator for more information.

USING THE UM8500 ASSISTANT
To Change Call Screening Options
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Call Transfer and Screening.
Save

Navigation pane

Screening
settings

3 In the Call Screening Settings section, select the call screening option.

Do NOT screen calls. The messaging system does not screen calls.
Screen calls to me. Ask for the caller’s name. The messaging system asks for
the caller’s name.
4 Click Save to save your changes.
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Changing Call
Handling when
your phone is
busy

When your phone is busy, you can have your callers wait on hold, depending on how the
messaging system is set up at your organization, this option might not be available. See your
system administrator for more information.

USING THE UM8500 ASSISTANT
To Change Call Handling when phone is busy
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Call Transfer and Screening.
Save

Navigation pane

Busy
options

3 Select whether callers are put on hold:

Ask caller to hold. The messaging system gives the caller the option to hold or leave a
message.
Put caller on hold... The messaging system automatically puts the caller on hold,
without the option to leave a message.
Send caller directly... The messaging system automatically routes the caller to a
greeting, without the option to hold, then prompts the caller to leave a message.
4
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Changing Call
Transfer Settings

You can change whether the messaging system transfers callers to an extension or routes callers
directly to a greeting to leave a message. You can also change the phone number where your
callers are transferred.
Depending on how the messaging system is set up at your organization, this option might not be
available. You can still change the call transfer options using the Redirect my calls feature, see
“Redirecting Calls to the Number you are calling from” on page 86.
NOTE
If FindMe FollowMe is enabled, this option is not available. Instead, the
messaging system uses the call transfer settings in the current FollowMe
policy.

USING A PHONE
To Change Call Transfer Settings
1 Call the messaging system and log on.
2 Press 4 > 1 > 2.
3 Press 1 to switch between transferring calls to an extension and to your greeting, or

press 2 to change your transfer phone number. To transfer calls to an external phone
number, contact your system administrator.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Change Call Transfer Settings
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click Call Transfer and Screening.
Save

Navigation pane

Call
transfer
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3 Select one of the following transfer settings:

Yes, ring my extension. Calls ring your extension.
Yes, ring me at this number. Calls the extension or phone number specified. To
transfer calls to an external phone number, contact your system administrator.
No (send directly to my greeting). Calls are transferred to your greeting. The
phone does not ring.
4 Click Save to save your changes.
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Changing Caller
Message Options

You can set whether your callers can edit their messages, whether your callers can leave urgent
messages, and whether or not your callers are asked to enter a phone number before being
transferred to your extension.

USING THE UM8500 ASSISTANT
To Change Caller Message Options
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Caller Options.
Navigation pane
Save

Caller
options

3 Select what callers can do when they leave messages.

Caller can edit the message. Callers can edit the message they recorded.
Caller can mark the message as urgent. Callers can mark the message as urgent.
Caller can leave callback number. Callers can leave a callback number.
4 Click Save to save your changes.
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Redirecting Calls
to the Number
you are calling
from

If you call the messaging system and log on into your mailbox, you can easily route calls to the
number you are calling from.
For example, if you are stuck in traffic in your way to the office, you can use this option to
transfer calls to your cell phone.
NOTE
Depending on how the messaging system is set up at your organization, this
option may not be available.
In addition, this option is not available if your phone service does not support
Caller ID.

USING A PHONE
To Redirect Calls to the Number you are calling from
1 Call the messaging system and log on.
2 Press 8.
3 Press 1 to redirect your calls to the number you are calling from.

Other options
OPTION

Other transfer options

KEY

2

OPTION

KEY

Override/revert to normal FindMe
FollowMe policies

3

Use these keys anytime
TASK

Cancel or back up
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■ Changing Message Settings
Message settings control how the messaging system announces messages and some options for the
messages sent. Use message settings to set up external mailboxes for checking other e-mail
accounts. The following settings can be controlled:

Message types. Select the types of messages for which count totals are announced
before playing messages.
Message summary information. Select the summary information, such as sender,
date and time, you want to hear about messages before or after the message is played.
Log on greeting. Select whether the messaging system plays your recorded name
when you log on.
Message addressing. Select how messages are addressed to other subscribers when
you send messages by phone.
Message auto-copy. Select to copy incoming voice messages to another subscriber.
Sound notification. Select the sound that notifies you at your computer when new
voice messages arrive in the Inbox.

In this Chapter...
Changing Message Type Announcements ................................................................... 88
Changing Message Summary Information.................................................................. 89
Changing the Log On Greeting ................................................................................. 90
Changing Message Addressing Settings ..................................................................... 91
Changing Message Auto-copy Settings ...................................................................... 92
Setting Up an External Mailbox ................................................................................ 98
Changing the New Voice Message Notification Sound................................................. 100
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Changing
Message Type
Announcements

The messaging system announces the number of messages and plays new messages in the
following order: urgent receipts, regular receipts, urgent voice, regular voice, urgent fax, regular
fax, urgent e-mail, regular e-mail.
The messaging system plays old messages in the same order after playing new messages.
The messaging system only plays message summary information for fax messages.

USING THE UM8500 ASSISTANT
To Change Message Types Announced
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Message Playback.
Save
Navigation Pane

Message
counts

3 Select the types of messages you want to hear when you check messages by phone.

All new messages. Announce the total number of all new messages.
All saved messages. Announce the total number of saved messages.
New voice messages. Announce the total number of new voice messages.
Do not announce. Clear all check boxes to not announce the number of messages.
4 Click Save to save your changes.
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Changing
Message
Summary
Information

You can set whether the messaging system tells you a sender’s name, the sequence number of a
message, and whether or not a message time stamp is played before or after the message. This
information is called the message summary.

USING THE UM8500 ASSISTANT
To Change Message Summary Information
1 Log on to the UM8500 Assistant.
2 In the navigation pane under Message Settings, click Message Playback.
Save

Navigation Pane

Message
summary

3 Select the summary information you want to hear about your messages:

Announce sender’s name. The messaging system plays the recorded name of the
subscriber who sent a message.
Announce message number. The messaging system announces the sequential
number of a message.
Announce time stamp... The messaging system announces the day, date, and time
that a message was received. Select either the before or after check box.
4 Click Save to save your changes.
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Changing the Log
On Greeting

You can set whether the messaging system greets you by name each time you call the system to
log on.

USING THE UM8500 ASSISTANT
To Change the Log On Greeting
1 Log on to the UM8500 Assistant.
2 In the navigation pane under Message Settings, click Message Playback.
Save
Navigation Pane
Play your
name

3 Select the Greet me by name check box to have the messaging system play your

recorded name when you log on. clear the check box if you do not want the messaging
system to play your recorded name.
4 Click Save to save your changes.
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Changing Message Addressing Settings
You can set whether you address messages by first name, last name, or extension number.

USING THE UM8500 ASSISTANT
To Change Message Addressing Settings
1 Log on to the UM8500 Assistant.
2 In the navigation pane under Message Settings, click Message Options.
Save

Navigation Pane

Select an
addressing
option

3 Select an option for addressing messages.
4 Click Save to save your changes.
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Changing
Message Autocopy Settings

When the message auto-copy feature is available, you can have a copy of new voice messages
automatically sent to another mailbox. Your system administrator can tell you whether this
feature is available.
The messages in your inbox may remain new or can be marked as saved, depending on the
option you specify.
You can choose which messages are auto-copied, for example you can choose to auto-copy
only messages from subscribers, from outside callers, or from both.
The auto-copy feature is available only for new voice messages. In some cases, the auto-copy
feature may not be available, for example private messages cannot be auto-copied.

Enabling and Disabling Message Auto-copy
When you receive a new voice message a copy is automatically sent to the selected mailbox
when auto-copy is enabled.
You can enable or disable the message auto-copy option using the phone or the UM8500
Assistant.

USING A PHONE
To Enable or Disable Message Auto-copy
1 Call the messaging system and log on.
2 Press 4 > 2 > 6.
3 After the messaging system announces the message auto-copy status, press 1 to enable

auto-copy or disable auto-copy.
4 If you enabled message auto-copy, set the message recipients. Use the phone keys to spell

the name of the recipient of the auto-copy messages.
Press # to save the changes.

Use these keys anytime
TASK

Cancel or back up
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USING THE UM8500 ASSISTANT
To Enable or Disable Message Auto-copy
1 Log on to the UM8500 Assistant.
2 In the navigation pane under Message Settings, click Message Options.
Save

Navigation Pane

Enable
message
auto-copy
Message
types to
auto-copy
Recipient
selection

3 Select Enable message auto-copy to enable the message auto-copy option.

Clear the Enable message auto-copy check box to disable the message auto-copy
option.
4 Select the Messages remain new check box to keep the auto-copied messages marked

new.
5 Select if the auto-copy applies to All messages or Messages from... Subscribers

or Outside callers.

If you selected to auto-copy messages from messaging system subscribers, you can also
auto-copy the messages from subscribers sent by a distribution list that you are a member
of. This option cannot be controlled using the phone.
6 Click Select.

The Subscriber Selection dialog box appears. Select the recipient of the auto-copy
message, then click Select to save the recipient.
7 Select the Auto-copy expires check box. The current date and time appear in the

expiration field.
Click Set to specify a date on which messages are no longer copied to the selected
subscriber. Auto-copy is automatically disabled (the Enable message auto-copy option is
no longer selected) at the end-of-day on the specified date.
8 Click Save to save your changes.
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Changing the Message Auto-copy Recipient
You can change who receives a copy of your messages. The message auto-copy feature cannot
be enabled unless a recipient is specified.
The message recipient can be changed by phone or using the UM8500 Assistant.

USING A PHONE
To Change the Message Auto-copy Recipient
1 Call the messaging system and log on.
2 Press 4 > 2 > 6 > 4.
3 Use the phone keys to spell the name of the recipient of the auto-copy messages.

Press # to save the changes.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Change the Message Auto-copy Recipient
1 Log on to the UM8500 Assistant.
2 In the navigation pane under Message Settings, click Message Options.
Save

Navigation Pane

Recipient
selection

3 Click Select, then use the Subscriber Selection dialog box to select the recipient of

the auto-copy message.
Click Select to save the recipient.
4 Click Save to save your changes.
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Changing the Message Auto-copy Type
You can specify which new messages are auto-copied by changing the messages types. For
example, you may choose to auto-copy all messages, only messages from other subscribers, or
only messages from outside callers.
The message auto-copy type can be changed using the phone or the UM8500 Assistant.

USING A PHONE
To Change Message Auto-copy Types
1 Call the messaging system and log on.
2 Press 4 > 2 > 6 > 3.
3 Select the types of message you want to auto-copy.
■

Press 1 to auto-copy all messages.

■

Press 2 to only auto-copy messages from outside callers.

■

Press 3 to only auto-copy messages from messaging system subscribers.

Press # to save the changes.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Change Message Auto-Copy Types
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Message Options.
Save

Navigation Pane

Message
types to
auto-copy
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3 Select if the auto-copy applies to All messages or Messages from... Subscribers

or Outside callers.

If you selected to auto-copy messages from messaging system subscribers, you can also
auto-copy the messages from subscribers sent by a distribution list that you are a member
of. This option cannot be controlled using the phone.
4 Click Save to save your changes.

Changing the Message Auto-copy Expiration Date
You can set an expiration date with the message auto-copy feature. The message auto-copy
remains in effect until the expiration date/time is reached. After that, the message auto-copy is
disabled. If no expiration date is set, messages are auto-copied until the feature is disabled.
The message auto-copy expiration can be changed using the phone or the UM8500 Assistant.

USING A PHONE
To Change the Message Auto-copy Expiration Date
1 Call the messaging system and log on.
2 Press 4 > 2 > 6 > 5.
3 Enter the expiration date information:
■

Enter the expiration month using the phone keys, pressing 1 to 1 2.

■

Enter the expiration date using the phone keys, pressing 1 to 3 1.

Press # to save the changes.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Change the Message Auto-copy Expiration Date
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Message Options.
Save

Navigation Pane

Auto-copy
expiration
setting
3 Select the Auto-copy expires check box. The current date and time appear in the

expiration field.
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Click Set to set an expiration date. Auto-copy is automatically disabled at midnight on the
selected date.
4 Click Save to save your changes.
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Setting Up an
External Mailbox

If you are using the text-to-speech option, and your system administrator has turned on this
feature for you, you can check messages for one internal e-mail Inbox, and up to nine different
external e-mail accounts. An external mailbox can be on another e-mail system such as Lotus
Notes or GroupWise, or an Internet e-mail account.
The external mailboxes option is enabled by your system administrator. You must provide your
system administrator with the following information for each external mailbox:
●

mailbox name,

●

incoming mail server (IMAP) name

●

account name and password

●

outgoing mail server (SMTP) name

●

SMTP server address.

This information can be provided to you by your Internet service provider. With this
information, your administrator defines the external mailbox for you. Once the external
mailbox is defined, you can see it using the UM8500 Assistant.
NOTE
You will only be able to edit the mailbox name, recorded name, password, and
Advanced Settings fields. All other fields are read-only.
For the special external mailbox created by the system for UM and VM
Directory User subscribers you will only be able to edit the recorded name and
password fields.

USING THE UM8500 ASSISTANT
To Set Up an External Mailbox
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click External Mailbox.
Navigation Pane
List of
external
mailboxes

3 On the Choose External Mailbox list box, select a mailbox.
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4 In the Mailbox Name field, type a descriptive name for the box.
NOTE
This field can be edited for all external mailboxes except for the special
external mailbox created by the system for UM and VM Directory User
subscribers.
The special external mailbox is the Exchange mailbox associated with the UM
Subscriber or VM Directory User and is named Exchange Mailbox by the
system.
5 On the Audio Control bar, click Record and record the name using the selected recording

device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
6 When you finish recording, click Stop.
7 In the Password field, type the external e-mail system password.
IMPORTANT
This field can be edited for all external mailboxes. In the case of the special
external mailbox created by the system for UM and VM Directory User
subscribers the password provided must be the password for the Windows
logon.
This field is case-sensitive.
8 In the Confirm Password field, type the password again.
9 If you are working with the Exchange Mailbox, go to step 15.
10 In the Incoming mail server (IMAP) port number field, type the port number of

the incoming mail (IMAP) server. The default value is 143.
11 Select The specified incoming mail server (IMAP) requires a secure

connection (SSL) to use Secure Socket Layer (SSL) security protocol when connecting
to the incoming mail server. If this option is selected the port number changes to 993.

12 In the Outgoing mail (SMTP) port number field, type the port number of the

outgoing mail (SMTP) server. The default value is 25.
13 Select The specified outgoing mail server (SMTP) requires a secure

connection (SSL) to use Secure Socket Layer (SSL) security protocol when connecting
to the outgoing mail server.

14 Select The specified outgoing mail server (SMTP) requires authentication

to specify that the outgoing mail server requires logon.
If this option is selected, select to Use same settings as incoming mail server
(IMAP) or Log on using a specified account and password.
■

If Log on using a specified account and password is selected, type the
Account name, Password, and Confirm password for the account.

15 Click Save to save your changes.
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Changing the New Voice Message Notification Sound
This option is available only if you use Unified Messaging for Outlook and your computer has
multimedia speakers.
NOTE
This procedure only applies if you have Unified Messaging for Outlook installed.
If you do not know if this option installed, contact your system administrator.

USING E-MAIL
To Change the New Voice Message Notification Sound
1 Click the Tools > Options, the Options dialog box appears.

Click the Unified Messaging for Outlook tab.
2 Select or clear the Play urgent message sound check box or Play new message

sound check box.
■

To preview the sound for an option, click the corresponding

.

■

To change the sound for an option, click the corresponding Browse button.
In the Browse Files dialog box, select a sound (WAV) file, then click Open.

3 Click OK to save your changes.
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■ Changing Settings for Devices used
for Message Notification

The messaging system can call a phone or pager to notify you of new messages. When you
answer a notification call, you can log on to the messaging system immediately to check your
messages.
The messaging system can delivery faxes to a fax machine or phone with fax capability.
The messaging system can also notify you of new messages by sending you a text message. the
messaging system can send the notification message to a text pager, to a text-compatible cell
phone, or to an e-mail account.
The messaging system calls a phone, pager, or fax based on notification schedules and options
that you set in the UM8500 Assistant. For the messaging system to make notification calls, the
phone or pager must be enabled or turned on.
You can turn notification on and off by phone, and change notification phone numbers for your
home phone, work phone, a pager, and a spare phone. In the UM8500 Assistant, you can set up
notification for your home phone, work phone, two mobile phones, five additional phones, two
pagers, four text pagers, and a spare phone.

In this Chapter...
Initial Device Message Notification Setup................................................................. 102
Enabling or Disabling a Device ............................................................................... 103
Changing a Device Phone Number .......................................................................... 104
Changing Text Pager Device Settings ...................................................................... 106
Changing Fax Device Settings ................................................................................ 107
Changing the Types of Messages for Notification ....................................................... 108
Changing a Device Schedule .................................................................................. 109
Changing Device Notification Options ...................................................................... 110
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Initial Device
Message
Notification Setup

While there are some differences in how phones and pagers are set up and used by the
messaging system, they are generically referred to as devices.
The first time you set up a device for message notification, you should follow all of the
procedures in this chapter for the device.
NOTE
Depending on your system configuration, you can set the messaging system to
notify you on a series of devices, one after another. This type of notification is
called cascading or chaining. For instructions to set up this type of notification,
contact your system administrator.
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Enabling or
Disabling a
Device

You can turn notification on and off for your home phone, work phone, a pager, and a spare
phone using the phone or the UM8500 Assistant. Additional notification devices can be turned
on and off for message notification using the UM8500 Assistant. Disabling a phone or pager
does not delete its notification settings.

USING A PHONE
To Enable or Disable a Notification Device
1 Call the messaging system and log on.
2 Press 4 > 2 > 1.
3 After the messaging system announces your notification status, press the corresponding

key for the phone or pager you want to change.
4 Press 1 to enable or disable notification to the phone or pager.

Device options
OPTION

KEY

Pager

1
2

Home phone

OPTION

KEY

Work phone

3
4

Spare phone

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Enable or Disable a Notification Device
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Devices.
Save

Navigation pane

Device
list

Status

3 Select the device you want to enable or disable.
4 Click Enabled or Disabled.
5 Click Save to save your changes.

UNIVERGE UM8500 USER GUIDE

CHANGING SETTINGS FOR DEVICES USED FOR MESSAGE NOTIFICATION

103

Changing a
Device Phone
Number

You can change the device number for your home phone, work phone, a pager and a spare
phone using the phone or the UM8500 Assistant. Additional device numbers can be changed in
the UM8500 Assistant.
When using a phone to enter phone numbers, begin with any access code needed to make an
external call (for example, 9). For long-distance numbers, include 1 and the area code. Use the
# key to add 1-second pauses. Depending on how the messaging system is set up, you might
not be able to enter certain phone numbers.
When typing phone numbers in the UM8500 Assistant, do not use spaces, dashes, or
parentheses between digits. Begin with any access code needed to make an external call (for
example, 9). For long-distance numbers, include 1 and the area code. Use commas (,) to add
1-second pauses, as necessary. Depending on how the messaging system is set up, you might
not be able to enter certain phone numbers.

USING A PHONE
To Change a Device Phone Number
1 Call the messaging system and log on.
2 Press 4 > 2 > 1.
3 After the messaging system announces your notification status, press the corresponding

key for the phone or pager whose number you want to change.
4 Press 3 to change the device’s number.
5 Enter the new number, or press # to keep the current number.
NOTE
Enter only an extension when you use phone numbers inside your
organization.

Device options
OPTION

KEY

Pager
Home phone

1
2

OPTION

KEY

Work phone

3
4

Spare phone

Use these keys anytime
TASK

KEY

Cancel or back up
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USING THE UM8500 ASSISTANT
To Change a Device Phone Number
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Devices.
Navigation pane

Save

Device
list
Phone
number
Status

Notification
options

3 Select the phone or pager whose number you want to change.
4 Type the number of the phone or pager.

When typing phone numbers do not use spaces, dashes, or parentheses between digits.
Start with any access code needed to make an external call (for example, 9).
For long-distance numbers, also include 1 and the area code. Use commas (,) to add
1-second pauses.
5 Type any extra digits related to the phone or pager.

These digits could be a password or an access number that you enter to hear messages, or
an ID required by a pager.
6 Click Enabled or Disabled to set the notification status of the device.
7 Select message types you want to be notified of and whether you want the notification

message to include a count of the messages.
8 At the bottom of the devices page, select dialing options for the extra digits:

Try to detect... The messaging system automatically tries to detect a connection to the
phone or pager before dialing the extra digits.
Seconds to wait... The messaging system waits this length of time before dialing extra
digits, after dialing the number.

Tip

You might need to experiment with this setting. Try 6 seconds, then
increase or decrease the time as needed.

9 Click Save to save your changes.
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Changing
Text Pager Device
Settings

You can set up two different devices or addresses to receive notification messages. You can
optionally specify a return phone number to be included in the text message. This is useful
because some cell phones allow you to press a button that automatically calls the return
number. If you specify a messaging system extension as the return number, the cell phone
immediately calls that extension to retrieve your messages.
The text pager device settings can only be changed using the UM8500 Assistant.

USING THE UM8500 ASSISTANT
To Change the Address and Text Settings for a Text Pager
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Devices.
Save

Navigation pane

Device
list
Pager
address
Return
number
Notification
text
Status
Notification
options

3 From the Device list box, select the text pager whose settings you want to change.
4 Type the e-mail address of the text pager.
5 Optionally, type the messaging system external phone number or other return phone

number that your cell phone calls after receiving the notification.

Tip

If you have a text-compatible cellular phone that is set up as a text
pager, you can activate the automatic callback function when this
number is displayed.

6 Type the notification message text you want to have sent. For example, You have voice

mail.
7 Click Enabled or Disabled to set the notification status of the text pager.
8 Select message types you want to be notified of and whether you want the notification

message to include a count of the messages.
9 Click Save to save your changes.
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Changing Fax
Device Settings

You can set up and change the settings for a device to deliver faxes using the UM8500 Assistant.

USING THE UM8500 ASSISTANT
To Change Fax Device Settings
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Devices.
Navigation pane

Save

Device
list
Phone
number
Status
Fax
settings
Notification
options

3 Select Fax in the Device list.
4 Type the number of the fax device.

When typing phone numbers do not use spaces, dashes, or parentheses between digits.
Start with any access code needed to make an external call (for example, 9).
For long distance numbers, also include 1 and the area code. Use commas (,) to add 1
second pauses.
5 Type any extra digits related to the phone or pager.

These digits could be a password or an access number for the fax device.
6 Click Enabled or Disabled to set the notification status of the device.
7 Select Include cover page to automatically include the fax cover sheet when the fax is

delivered.
8 Select if you want to be notified of a fax delivery Only if urgent.
9 Set the fax device notification schedule. See “Changing a Device Schedule” on page 109.
10 Click Save to save your changes.
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Changing the
Types of
Messages for
Notification

You can select the types of messages that the messaging system will send you a notification of.
These can be new voice messages, fax messages, e-mail messages, or any new message.
The message notification settings can only be changed using the UM8500 Assistant.

USING THE UM8500 ASSISTANT
To Change the Types of Messages for Notification
1 Log on to the UM8500 Assistant.
2 In the navigation pane under Message Settings, click Devices.
Navigation pane

Save

Device
list

Fax
settings
Message
types

3 Select the device you want to change.
4 If the device is a phone that can be used to deliver faxes, select Turn on automatic fax

delivery to automatically deliver the fax to the phone number. You can also select if the
cover sheet should be included with the fax.

5 Select message types you want to be notified of.
6 Select whether you want the notification message to include a count of the messages.
7 Click Save to save your changes.
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Changing a
Device Schedule

You can set the times that a device is active for notification. The messaging system does not
contact a device if the device schedule is set to inactive.
The device notification schedules can only be changed using the UM8500 Assistant.

USING THE UM8500 ASSISTANT
To Change a Notification Schedule
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Devices.
Save

Navigation pane

Device
list

Active or
inactive
times

3 Select the phone or pager whose schedule you want to change.
4 The schedule shows active times as white and inactive times as gray. Click the boxes to

change between inactive and active. The messaging system only sends new message
notification calls during the active hours.

Tip

Use the Copy day’s schedule function, below the schedule, to copy
the schedule from one day to other days.

5 Click Save to save your changes.
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Changing Device
Notification
Options

Use these options to set the timing and frequency of the calls that the messaging system uses to
notify you of new messages.
The device notification options can only be changed using the UM8500 Assistant.
NOTE
The notification options are not available for the fax device.

USING THE UM8500 ASSISTANT
To Change Notification Options
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Devices.
Save

Navigation pane
Device
list

Notification
options

3 Select the phone or pager whose notification options you want to change.
4 Select options for the phone or pager:
NOTE
If you are working with a text pager, only the Send initial notification,
Restart notification, and Repeat notification options are available.

Send initial notification... The messaging system sends the first notification call this
many minutes after a new message arrives.
Restart notification... The messaging system sends a notification call each time you
receive a new message.
Repeat notification... The messaging system sends regular notification calls at the
interval you set, as long as you have new messages.
If device does not answer. The messaging system follows your settings for an
unanswered device.
If device is busy. The messaging system follows your settings for a busy device.
If notification fails... When the messaging system cannot reach the phone or pager, it
can call an alternate device. The alternate device must be enabled and follows its own settings
and schedule.
5 Click Save to save your changes.
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■ Changing Private List Settings

Use private lists to create private groups of voice message recipients. When you address a voice
message to a private lists, all of the members of the list receive the message.
The messaging system provides 20 empty lists that you can personalize. Only you have access to
your private lists.
NOTE
You can send only voice messages to your private lists, and you can send
those messages only by calling and logging on to the messaging system.
You cannot send messages from your Inbox to your private lists.

In this Chapter...
Changing the Name of a Private List ....................................................................... 112
Changing the Members of a Private List................................................................... 113
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Changing the
Name of a Private
List

The name you type and record is for verification purposes only. When you address a voice
message to a private list, you address it, by using a list number (1 through 20). After you enter a
private list number, the messaging system plays the recorded name so you can confirm that
you have selected the correct list.
The private list settings can only be changed using the UM8500 Assistant.

USING THE UM8500 ASSISTANT
To Change the Name of a Private List
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Private Lists.
Save

Navigation Pane

Stop

Record

3 Select the private list whose name you want to change.
4 Type a name for the list.
5 On the Audio Control bar, click Record and record the list name with your recording

device:
Phone. Pick up the handset when the phone rings, wait for the tone, then speak into the
handset.
Multimedia microphone. Wait for the tone, then speak into the microphone.
6 Click Stop when you finish recording.
7 Click Save to save your changes.
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Changing the
Members of a
Private List

Each private list can contain up to 25 members. Private lists cannot be members of a private list.
However, a public distribution list can be a member of a private list.
Search for each subscriber or public distribution list that you want to add as a member of your
private list. You can search on the display name (full name), first name, last name, or extension.
Select a search method in the By drop-down list box.
The private list settings can be changed using the phone or the UM8500 Assistant.

USING A PHONE
To Add or Remove Members of a Private List
1 Call the messaging system and log on.
2 Press 4 > 2 > 4.
3 Press 2 to change the names on a list.

Spell the distribution list name, or enter the number of the list. Private lists are numbered 1
through 20. Press # to confirm the name or number.
After selecting a list, press 2 to hear the names on the list.
4 Press 1 to add a name to the list.

Use the phone keys to enter the name to add the person to the list. Press # to add the
name.
5 Press 3 to remove a name from the list.

Use the phone keys to enter the number of the person to remove from the list.

Use these keys anytime
TASK

KEY

Cancel or back up

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Add or Remove Members of a Private List
1 Log on to the UM8500 Assistant.
2 In the navigation pane under Message Settings, click Private Lists.

Find
members
List of
members
Save

Matching
names
3 Select the private list whose members you want to change.
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4 Click Change Members.
5 To find the subscriber you want to add, type the name in the Look for text box, then click

Find.

Tip

Type an asterisk (*) in the Look for text box to list all subscribers
and public distribution lists in your organization. This wildcard
character also can be used to search for partial matches. For
example, K* results in a list of all names beginning with the letter K.

6 To add the name to the list, select the name from Matching names, then click

(Next).
7 To delete a name from the list, select the name from ... members, then click

(Previous)
8 Click Save to save the changes.
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■ Changing Caller Options

You can use UM8500 Assistant to set whether or not your callers can edit their messages, can
leave urgent messages, and are asked to enter a callback phone number when leaving a
message.

In this Chapter...
Allowing Callers to Edit Their Messages ................................................................... 116
Allowing Callers to Leave Urgent Messages .............................................................. 117
Asking Callers to Enter a Callback Phone Number ..................................................... 118
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Allowing Callers
to Edit Their
Messages

You can specify if your callers can add to, listen to, or rerecord their messages.
The caller options settings can only be changed using the UM8500 Assistant.

USING THE UM8500 ASSISTANT
To Allow Callers to Edit Messages
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Caller Options.
Save

Navigation pane

Caller
options

3 Select the Caller can edit the message check box.
4 Click Save to save your changes.
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Allowing Callers
to Leave Urgent
Messages

You can specify if your callers can leave you urgent messages.
The caller options settings can only be changed using the UM8500 Assistant.

USING THE UM8500 ASSISTANT
To Allow Callers to Leave Urgent Messages
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Caller Options.
Save

Navigation pane

Caller
options

3 Select the Caller can mark the message as urgent check box.
4 Click Save to save your changes.
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Asking Callers to
Enter a Callback
Phone Number

You can specify if the messaging system asks callers to enter a phone number before leaving a
message. The messaging system uses the phone number to return a call. This option is useful if
you do not receive caller ID information from your phone service.
The caller options settings can only be changed using the UM8500 Assistant.

USING THE UM8500 ASSISTANT
To Enable Caller Leaving a Callback Number
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Message Settings, click Caller Options.
Save

Navigation pane

Caller
options

3 Select the Caller can leave callback number check box.
4 Click Save to save your changes.
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■ FindMe FollowMe

The FindMe FollowMe feature provides the messaging system with the ability to determine the
best way to contact you, route your messages, and manage your messages based upon your
schedule and other system information.
This feature may not be enabled on your messaging system. Contact your system administrator
for details.

In this Chapter...
Introducing FindMe FollowMe ................................................................................. 120
Determining the Current Scenario ........................................................................ 120
Applying the FollowMe Policy ............................................................................... 121
Creating a New Scenario for an Existing FollowMe Policy ............................................ 122
Creating a New Scenario with a New FollowMe Policy ................................................ 124
Overriding or Reverting to Normal FindMe FollowMe Policies ....................................... 126
Deleting a FollowMe Scenario................................................................................. 127
Editing a FollowMe Scenario................................................................................... 128
Editing a FollowMe Policy....................................................................................... 129
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Introducing
FindMe FollowMe

The FindMe FollowMe feature provides the capability of determining the correct method of
contacting you based on your schedule and other system information.
When using FindMe FollowMe, the messaging system uses your FollowMe policies and
scenarios to route your calls. To understand how FindMe FollowMe functions, it is important to
understand FollowMe policies and scenarios and how they function.
FollowMe policies are unique named rules that govern the actions the messaging system takes
to handle your calls; such as attempting a transfer, greeting a caller, letting the caller select an
action, taking a message, or routing the caller to another call handler.
Scenarios combine a FollowMe policy with scheduling information and defines when a
FollowMe policy is active. The messaging system uses the scenario to determine when a
particular FollowMe policy is used.
When you receive a new call, the messaging system reviews your active scenarios to determine
the current scenario and applies the FollowMe policy associated with the current scenario to
the call.
The following situations provide a brief explanation of how you can set up the FollowMe
scenarios and polices so that the messaging system takes the correct actions based on your
schedule:
●

You are working from home on Wednesday, Thursday, and Friday, you want the messaging
system to transfer calls to your home phone.
Create a scenario that applies during the Weekdays schedule and only for the days you are
working at home. You also need to configure a FollowMe policy to transfer your calls to
your home phone and associate the policy with the scenario.

Determining the Current Scenario
Your scenarios appear in a table in the UM8500 Assistant on the FindMe FollowMe page. The
table shows active scenarios, inactive scenarios, the current scenario, and, if Show expired
temporary scenarios is selected, any expired temporary scenarios.
An active scenario is a scenario that applies at that moment and is identified by a check mark in
the Active column of the scenario table. There can be several active scenarios at any one time,
but only one active scenario is the current scenario. When viewing the scenario table, the
current scenario is highlighted.
The system automatically creates two default scenarios for every user:
The ultimate fallback scenario. A permanent scenario that applies to all schedules
and statuses. This scenario cannot be modified or deleted, it is associated with the
FollowMe policy called Old Policy. But it can be assigned a different FollowMe policy.
The override scenario. A special scenario that overrides all scenarios when it is
enabled. It is always assigned to a specific FollowMe policy called Override. By default, this
scenario is disabled. You can enable or disable this scenario by phone only. See “Overriding
or Reverting to Normal FindMe FollowMe Policies” on page 126.
The messaging system checks the active scenarios in the following order to determine the
current scenario.
NOTE
The highest priority scenario may not be the current scenario, because the
schedule for the scenario can make the scenario not applicable.
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●

If there is an active Override scenario, then the Override scenario takes precedence over all
other scenarios.

●

Temporary scenarios are checked before permanent scenarios. A temporary scenario is a
scenario that has a start time and/or end time set; or does not have an end date, but has a
start date in the past. The other rules about determining sequence are subordinate to this.
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●

For temporary scenarios that are subject to the rules above:
Scenarios with start times are shown in order of start time and are shown before temporary
scenarios without start times. Scenarios without start times are shown in order of end time.

●

For scenarios that have the same start time and end time, scenarios with a Schedule of
Always are shown after the scenarios with a system schedule such as Weekdays or All Hours
- All Days.

Applying the FollowMe Policy
Once the current scenario is determined, the messaging system applies the FollowMe policy
associated with the scenario.
If a transfer rule is defined, the messaging system attempts the transfer. If the transfer is
successful the messaging system connects the caller to you and takes no further action. If the
policy is set to take a message, the messaging system takes the message. If not, it either says
good-bye or routes the call to another call handler.
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Creating a New
Scenario for an
Existing FollowMe
Policy

You can use the UM8500 Assistant to create a new scenario and assign it an existing FollowMe
policy.
NOTE
This option may not be enabled for your account. Contact your system
administrator for details.

USING THE UM8500 ASSISTANT
To Create a New Scenario for an Existing FollowMe Policy
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click FindMe FollowMe.
Save

Navigation pane

Add new
scenario

3 Click Add new scenario. The Add New Scenario Wizard starts.
4 Select Use predefined policy (e.g. "Def. Just take a message" or "Def.

Release to mobile phone") in the What type of policy do you want? dialog
box

5 Select when the policy applies:
■

■

Select Set policy for a specific period of time if you want this scenario to have
a start or end date.
Select Set policy for a specific voice mail schedule if you want this scenario
to apply only in open time intervals of a specific voice mail schedule.

6 Click Next.
7 Select an exiting policy to use with this scenario in the Choose predefined policy

dialog box, then click Next.

8 Specify when the policy applies in the Control when the policy will be applied

dialog box:
NOTE
The settings on this page depend on the selection in Step5.
■

Click Set to select an After and Until dates and times for the scenario.

■

Select the schedule in the During schedule field.

9 Click Next.
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10 Review the settings you have selected in the Final details dialog box:
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■

If the settings are correct, click Finish to add the scenario.

■

If the settings are not correct, click Prev to go back and modify the settings.
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Creating a New
Scenario with a
New FollowMe
Policy

You can use the UM8500 Assistant to create a new scenario and create a new FollowMe policy
for the scenario.
NOTE
This option may not be enabled for your account. Contact your system
administrator for details.

USING THE UM8500 ASSISTANT
To Create a New Scenario with a New FollowMe Policy
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click FindMe FollowMe.
Save

Navigation pane

Add new
scenario

3 Click Add new scenario.

The Add New Scenario Wizard starts.
4 Select Ring me at... (e.g. "my work phone" or "555-555-1212") in the What

type of policy do you want? dialog box.

5 Select when the policy applies:
■

■

Select Set policy for a specific period of time if you want this scenario to have
a start or end date.
Select Set policy for a specific voice mail schedule if you want this scenario
to apply only in open time intervals of a specific voice mail schedule.

6 Click Next.
7 Select if you want the messaging system to attempt transfer to one of your devices, or to

another phone number, or simply to play a greeting in the Identify phone dialog box.
IMPORTANT
If you set the transfer for a device, such as your Home Phone, ensure that the
device has a phone number set. If the device does not have a phone number
set, the messaging system does not attempt the transfer. See “Changing a
Device Phone Number” on page 104.

8 If you transfer to a device or specific number, select the action to be taken if number is

busy.
NOTE
These options may not be available at your site.
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9 If you transfer to a device or specific number, select the actions to be taken when you

answer the call.
NOTE
These options may not be available at your site.
10 Click Next.
11 Select if you want the messaging system to play a greeting if no transfer is set or if the

transfer fails, and then select the greeting to be played in the Greeting and take
message options dialog box.
■

Select if the Busy and Internal greetings are enabled for the policy.
NOTE
The Busy and Internal greetings cannot be enabled if the Alternate
greeting is used.

■

Select if you want callers to be able to bypass greeting.

12 Select the After greeting, take a message check box to have the FollowMe policy

take messages from callers.
■

Select if caller can edit messages and mark them as urgent.

■

Select if caller can leave a callback number before sending the message.

13 Click Next.
14 Specify when the policy applies in the Control when the policy will be applied

dialog box.
NOTE
The settings on this page depend on the selection in Step5.
■

Click Set to select an After and Until date and time for the scenario.

■

Select the schedule in the During schedule field.

15 Click Next.
16 Review the settings the Final details dialog box:
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■

If the settings are correct, click Finish to add the scenario.

■

If the settings are not correct, click Prev to go back and modify the settings.
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Overriding or
Reverting to
Normal FindMe
FollowMe Policies

When the override scenario is enabled, the messaging system ignores the other scenarios and
follows the Override policy settings.
For example, if you are stuck in traffic in your way to the office, you can enable your override
scenario by phone and the messaging system will transfer calls to your cell phone.
NOTE
When the override scenario is enabled, it appears in the scenarios table as the
current scenario. When it is disabled, it appears in the Expired scenarios table.

You can enable the override scenario over the phone.

USING A PHONE
To Enable or Disable the Override Scenario
1 Call the messaging system and log on.
2 Press 8.
3 If the normal FollowMe policies are not overridden, press 3 to override them or if the

normal FollowMe policies are overridden, press 3 to revert them.

Other options
OPTION

Redirect calls to the number you
are calling from or to a specific
number

KEY

1

OPTION

KEY

Other transfer options

2

Use these keys anytime
TASK

Cancel or back up
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Deleting a
FollowMe
Scenario

Delete a FollowMe scenario when it is no longer needed.
NOTE
This option may not be enabled for your account. Contact your system
administrator for details.

USING THE UM8500 ASSISTANT
To Delete a FollowMe Scenario
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click FindMe FollowMe.
Save

Navigation pane

3 In the scenario table, click Delete in the row corresponding to the scenario to delete.
4 Click OK to confirm the deletion or click Cancel to cancel deletion.
NOTE
Only the scenario is deleted. The associated FollowMe policy is not deleted,
even if it is not associated with another existing scenario. Contact your system
administrator to delete a policy.
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Editing a
FollowMe
Scenario

You can change the settings of a FollowMe scenario using UM8500 Assistant.
NOTE
This option may not be enabled for your account. Contact your system
administrator for details.

USING THE UM8500 ASSISTANT
To Edit a FollowMe Scenario
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click FindMe FollowMe.
Save

Navigation pane

Edit
scenario

3 In the scenario table, click Edit in the row for the scenario to edit.

The Edit Scenario dialog box appears.
4 Select the policy used for this scenario from the Policy list box.

If you want to edit the selected policy, see “Editing a FollowMe Policy” on page 129.
5 Click Set to select an After and Until date and time for the scenario.

Use the Set Date dialog box to select the date and time.
Click Delete to clear the date and time fields if you do not want this scenario to follow a
time interval.
6 Select the schedule in the During schedule field.

Select Always in the During schedule drop down list if you do not want this scenario
to follow a specific schedule.
7 Click OK to save your changes.
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Editing a
FollowMe Policy

You can change a FollowMe policy using UM8500 Assistant.
NOTE
This option may not be enabled for your account. Contact your system
administrator for details.

USING THE UM8500 ASSISTANT
To Edit a FollowMe Policy
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Call Settings, click FindMe FollowMe.
Save

Navigation pane

Edit
scenario

3 In the scenario table, click Edit in the row for the scenario to edit.

The Edit Scenario dialog box appears.
4 Select the policy you want to edit from the Policy list box.
5 Click Edit Policy. The Edit Policy dialog box appears.
IMPORTANT
A FollowMe policy may be used by multiple scenarios. The changes you make
to this policy affect all the scenarios that use the policy.
6 The Ring me at table shows the existing transfer settings of the policy. If the table is

empty, the no transfer option is configured.

a Click Edit to add or edit the transfer settings for the policy. The Add/Edit Phone

dialog box appears.
b Under Ring me at, choose if you want UM8500 to attempt transfer to one of your

devices or to another phone number, or simply to play a greeting.
IMPORTANT
If you set the transfer for a device, such as your Home Phone, ensure that
the device has a phone number set. If the device does not have a phone
number set, the messaging system does not attempt the transfer. See
“Changing a Device Phone Number” on page 104.
c If you choose transfer to a device or specific number, select the action to be taken if

number is busy.
NOTE
These options may not be available at your site.
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d If you choose transfer to a device or specific number, select the actions to be taken

when you answer the call.
NOTE
These options may not be available at your site.
e Click Save to save your changes.
7 Select if you want the messaging system to play a greeting if no transfer is set or if the

transfer fails, and the select the greeting to be played.
■

Select if the Busy and Internal greetings are enabled for the policy.
NOTE
The Busy and Internal greetings cannot be enabled if the Alternate
greeting is used.

■

Select if you want to allow caller to bypass greeting or not.

8 Select the After greeting, take a message check box to have the FollowMe policy

take messages from callers.
■

Select if caller can edit messages and mark them as urgent

■

Select if caller can leave a callback number before sending the message

9 Click OK to save your changes.

UNIVERGE UM8500 USER GUIDE

FINDME FOLLOWME

130

■ Sharing a Phone

The procedures in this section show you how to set call handling for shared phones.
The messaging system can be set up to for up to nine subscribers to share a single phone. To
reach you, a caller dials the extension number of the shared phone, then the caller hears a
menu of all subscribers sharing the phone. The caller presses a key corresponding to your
name.
Initially, your system administrator sets whether the shared phone rings when you receive a
call, or if callers are routed directly to your greeting. Your system administrator also sets
whether callers are allowed to hold when the shared phone is busy, and how calls are
announced before they are connected, The system administrator can record a greeting for the
shared phone.
Each subscriber assigned to a shared phone uses the UM8500 Assistant to change the settings
for call transfer, call holding, and the shared greeting. When you change these settings, you
change them for all subscribers assigned to the shared phone.
If you share a phone, you can be listed in the directory individually. Shared extensions are not
listed in the directory.

In this Chapter...
Answering a Call on a shared Phone ....................................................................... 132
Checking Messages from a Shared Phone ................................................................ 133
Changing Call Transfer for a Shared Phone .............................................................. 134
Setting Call Handling for a Shared Phone................................................................. 135
Setting Call Announcements for a Shared Phone....................................................... 136
Setting Call Screening for a Shared Phone ............................................................... 137
Recording Greetings for a Shared Phone.................................................................. 138
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Answering a Call
on a shared
Phone

When you answer a call on a shared phone, the messaging system can announce who the call is
for, then asks whether to connect the call or take a message.
If the shared phone is not answered, callers can leave a message in your mailbox. If the shared
phone is busy, callers can hold or route directly to your greeting to leave a message.
The shared extension can be set up to allow callers to leave the same message for everyone who
shares the phone. See your system administrator for more information.

USING A PHONE
To Answer a Call on a Shared Phone
1 When the shared phone rings, answer it.
2 If asked, to accept the call, press 1.
3 To route the caller to the called recipient’s mailbox to leave a message, press 2.
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Checking
Messages from a
Shared Phone

You can use a shared phone to log on to the messaging system and check messages.
The shared extension can be set up so callers can leave a message for you or to leave the
message for everyone who shares the phone. See your system administrator for more
information.
Message waiting indication is turned on when any subscriber sharing the phone receives a
message. Message waiting indication is turned off when none of the subscribers has a new
message waiting.

USING A PHONE
To Check Messages from a Shared Phone
1 Using the shared phone, call the messaging system.
2 When the messaging system plays the menu that lists each person sharing the phone, press

the key associated with your name, or for a different mailbox, press # followed by the
extension number. Press # to finish.
3 Enter your password.
4 Press 1 to hear new messages, or press 3 to review old messages.

Use these keys during a message
TASK

Repeat
Save
Delete
Change volume

KEY

1
2
3
5

TASK

KEY

Reverse

7
8
9

Pause or continue
Fast-forward to end

Use these keys after a message
TASK

Repeat
Save
Delete
Return call
Reply to all
Reply to sender

KEYS

1
2
3
41
44
4#

TASK

KEY

Forward message

5
6
7
8
9

Mark as new
Reverse
Deliver an e-mail or fax to a fax
phone number *
Hear summary

* Available only with a fax installation.

Use these keys anytime
TASK

Cancel or back up
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Changing Call
Transfer for a
Shared Phone

You can set whether a shared phone rings when you have a call, or whether callers are routed
directly to your mailbox greeting to record a message.
The call transfer settings for a shared phone can be changed using a phone or the UM8500
Assistant.

USING A PHONE
To Change Call Transfer for a Shared Phone
1 Call the messaging system and log on.
2 Press 4 > 4 > 2.
3 After the messaging system tells you the current status of call transfer to the shared phone,

press 1 to change it.

USING THE UM8500 ASSISTANT
To Change Call Transfer for a Shared Phone
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Shared Extension Settings, click Call Transfer

Settings.

Transfer
settings

3 To set the shared phone to ring, select Yes, ring at shared extension, or

to route callers to your mailbox, select No (send directly to my greeting).
4 Click Save to save your changes.
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Setting Call
Handling for a
Shared Phone

You can set how the messaging system handles callers when a shared phone is busy. For
example, you can allow callers to hold or route them directly to the shared greeting to record a
message. Call holding is available only with supervised call transfers. See your system
administrator for more information.
Use the UM8500 Assistant to change call handling setting for a shared phone.

USING THE UM8500 ASSISTANT
To Set Call Handling for a Shared Phone
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Shared Extension Settings, click Call Transfer

Settings.

Busy call handling

3 Select an action for when the phone is busy:

Ask caller to hold. The messaging system gives the caller the option to hold or leave a
message.
Put caller on hold... The messaging system automatically puts the caller on hold,
without the option to leave a message.
Send caller directly... The messaging system automatically routes the caller to your
greeting, without the option to hold, then prompts the caller to leave a message.
4 Click Save to save your changes.
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Setting Call
Announcements
for a Shared
Phone

The messaging system can be set up to announce who a call is for before the call is connected.
You can also set the messaging system to ask the person who answers a call whether to accept it
or route the call to a mailbox to take a message.
Announced calls are available only with supervised call transfers. See your system
administrator for details.
Use the UM8500 Assistant to set or change call announcement settings for shared phones.

USING THE UM8500 ASSISTANT
To Set Call Announcements for a Shared Phone
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Shared Extension Settings, click Call Transfer

Settings.

Call announcement

3 Select one or more of the settings you want the messaging system to use when you answer

the phone:
Tell me who the call is for. The messaging system announces whom the call is for.
Announce before connecting caller to me. The messaging system announces
the call before connecting the caller.
Ask shared extension subscriber to confirm. The messaging system asks the
person who answers the shared phone if it should connect the caller.
4 Click Save to save your changes.
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Setting Call
Screening for a
Shared Phone

You can set whether the messaging system asks callers to record their name before transferring
the call to a shared phone. The messaging system then plays the caller’s name before
connecting the call.
Call screening is available only with supervised call transfers. See your system administrator for
more information.
Use the UM8500 Assistant to change the call screening for a shared phone.

USING THE UM8500 ASSISTANT
To Set Call Screening for a Shared Phone
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Shared Extension Settings, click Call Transfer

Settings.

Call screening
settings

3 In the Call Screening Settings group, select one of the following:

Do NOT screen calls to shared extension subscriber. The messaging system
transfers calls without asking a caller’s name.
Screen calls to shared extension subscriber. The messaging system asks for the
caller’s name before transferring the call.
4 Click Save to save your changes.
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Recording
Greetings for a
Shared Phone

You can record a greeting for a shared phone. If you do not record a greeting, the messaging
system creates a default greeting, assigns a menu, and plays the recorded name for each
subscriber sharing the phone.
Plan carefully before changing the greeting for a shared phone. The rerecorded greeting plays
for anyone who reaches the shared phone, not just for your callers. The greeting should include
the names of the subscribers sharing the phone, tells callers which key to press to reach each
subscriber.
If callers can press # to leave a message for everyone who shares the phone, you should
include instructions in the greeting. See your system administrator for more information.
Record greetings for a shared phone using the phone or the UM8500 Assistant.

USING A PHONE
To Record Greetings for a Shared Phone
1 Call the messaging system and log on.
2 Press 4 > 4 > 1.
3 After the messaging system plays your current shared greeting, press 1 to rerecord it, or

press 3 to select and rerecord a different greeting.
If you pressed 3 to edit other greetings, select the greeting by pressing the corresponding
menu-key, then press 1 to rerecord-it.
GREETING

KEY

Standard

1
3

Alternate

GREETING

KEY

Closed

2

Use these keys as you record
TASK

Pause or continue

KEY

8

TASK

KEY

End recording

#

Use these keys anytime
TASK

Cancel or back up

KEY

*

TASK

KEY

Skip or move ahead

#

USING THE UM8500 ASSISTANT
To Record Greetings for a Shared Phone
1 Log on to the UM8500 Assistant.
2 In the navigation pane, under Shared Extension Settings, click Greetings.

Greetings
list box
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3 In the Greeting list box, select the greeting.
4 In the Status group, select Enabled to turn on the greeting. Select Disabled to turn off

the greeting.
NOTE
The Standard greeting cannot be disabled.
5 In the Source group, to use the default greeting created automatically by the messaging

system, select Use system prompt.

Select Record my greeting to record a greeting.
6 On the Audio Control bar, click the Record icon. Click Stop when you have finished the

recording.
7 To allow your callers to skip the greeting by pressing #, select Bypass greeting, or to

require that callers hear the entire greeting before taking an action, clear this check box.
8 Click Save to save your changes.
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